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 โปรแกรม  Microsoft Excel คืออะไร 

 
icrosoft Excel เป็นโปรแกรมประเภท Spreadsheet ซึ่งออกแบบมาสำหรับบันทึกวิเคราะห์  
และแสดงข้อมูลเกี่ยวกับตัวเลขได้อย่างมีประสิทธิภาพ ทั้งในรูปแบบของแผนภาพหรือรายงาน ซึ่ง
โปรแแกรม Microsoft Excel ยังมีความสามารถในการจัดรูปแบบเอกสารได้สวยงาม และง่ายดาย

ไม่แพ้โปรแกรมอ่ืนๆ เลยทีเดียว 

โดยโปรแกรม Microsoft Office 2019 ได ้ร ับการพัฒนาต่อจาก Microsoft 
Office 2016 และเปิดใช้งานตั้งแต่เดือนกันยายน 2018 โดย Microsof Office 2019 เป็น
โปรแกรมที่พัฒนาให้ติดตั้งบนเครื่องคอมพิวเตอร์ที่มีระบบปฏิบัติการ Windows 2010 
(ทำงานแบบ Offline) โดย Microsoft ได้ประกาศว่าจะให้การสนับสนุนการทำงานของ
ผู้ใช้ Microsoft Office 2019 ต่อไปจนถึงปี 2025 ซึ่งปัจจุบันผู้ใช้งานสามารถมีทางเลือกใน
การใช้งานโปรแกรม Microsoft Office ได้ 2 แบบคือโปรแกรมที่ติดตั้งบนเครื่องคอมพิวเตอร์ และโปรแกรมที่
ติดตั้งบนระบบ Cloud อย่างโปรแกรม Microsoft Office 365  

เนื่องจากปัจจุบันผู้ใช้งานยังไม่มั่นใจในระบบความปลอดภัยของโปรแกรมบน Cloud ทำให้ Microsoft 
ยังคง Update โปรแกรม Microsoft Office 2019 ปีละ 2 ครั้ง โดย Microsoft Office 2019 ยังได้รับการเพ่ิมใน
ส่วนของลูกเล่นและฟังก์ชันการทำงานให้มีความเป็นมือาชีพมากกว่า Microsoft Office 2016 โดยโปรแกรม 
Microsoft Excel เป็นหนึ่งในโปรแกรมของโปรแกรม Microsoft Office Suite ซึ่งประกอบด้วยโปรแกรม  หลักๆ 

Ref : https://support.microsoft.com/en-in/lifecycle/search/914 
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 Microsoft Office 2019 vs Microsoft Office 365 

 
 

รายละเอียด Office 2019 Office 365 

ค่าใช้จ่าย จ่ายครั้งเดียว จ่ายรายเดือน/รายปี จำนวนน้อย 

วิธีการติดตั้ง ติดตั้งในคอมพิวเตอร์ ไม่ต้องติดตั้ง ทำงานอยู่บนระบบคลาวด์ 

จำนวนการติดตั้ง ติดตั้งได้เครื่องเดียว  
(บนพีซีหรือ Mac) 

ติดตั้งและใช้งานได้ 5 อุปกรณ ์

อัพเกรดความสามารถใหม่ๆ ไม่มี อัพเกรดตลอดเวลา 

พื้นที่ฟรีบนคลาวด์ ไม่มี มีพ้ืนที่ฟรีบนคลาวด์ 1 TB 
(บน Cloud ของ OneDrive สำหรับผู้ใช้ แต่ละ
ราย สูงสุด 6 คน รวมทั้งตัวคุณเอง (Office 365 

Home)) 

รองรับการซับพอร์ต ไม่มี มี 
ติดต่อเราได้ตลอดการสมัครใช้งาน เพื่อรับความ
ช่วยเหลือเกี่ยวกับปัญหาด้านเทคนิค หรือการ

สนับสนุนเกี่ยวกับการสมัครใช้งานและการเรียก
เก็บเงิน โดยไม่มีค่าใช้จ่ายเพ่ิมเติม 

แอพพลิเคชั่น รับแอป Office 2019 เช่น 
Excel, Word และ 

PowerPoint 

Excel, Word, PowerPoint และ Outlook 
ได้รับฟีเจอร์ล่าสุด เครื่องมือใหม่ การอปัเดต
ความปลอดภัย และการแก้ไขข้อบกพร่องอยู่

เสมอ ผู้ใช้พีซียังจะได้รับ Access และ 
Publisher อีกด้วย 

Ref : https://technointrend.com/office2019-vs-ofice365/ 
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Ref : https://www.microsoft.com/en/microsoft-365/buy/compare-all-microsoft-365-products-
b?=&market=af&ef_id=EAIaIQobChMIja78tLTo7AIVVwQrCh10aAUvEAAYASAAEgLKu_D_BwE%3AG%3As&ocid=AID2100138_
SEM_EAIaIQobChMIja78tLTo7AIVVwQrCh10aAUvEAAYASAAEgLKu_D_BwE%3AG%3As&lnkd=Google_O365SMB_Brand&gclid
=EAIaIQobChMIja78tLTo7AIVVwQrCh10aAUvEAAYASAAEgLKu_D_BwE 
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 What is new in Microsoft Office Excel 2019? 

 

Ref : https://support.microsoft.com/en-us/office/what-s-new-in-excel-2019-for-windows-
5a201203-1155-4055-82a5-82bf0994631f 

New Feature Detail Example 
New Functios - Concat : This new function 

is like CONCATENATE, but 
better. First of all, it's 
shorter and easier to type. 
But it also supports range 
references, in addition to 
cell references. 

-  

CONCAT(text1, [text2],…) 

 - IFS : Tired of typing 
complicated, nested IF 
functions? The IFS function 
is the solution. With this 
function, conditions are 
tested in the order that you 
specify. If passed, the result 
is returned. You can also 
specify an else "catch all" if 
none of the conditions are 
met. 

=IFS([Something is True1, Value if 
True1,Something is True2,Value if 
True2,Something is True3,Value if 
True3) 

 - MAXIFS : This function 
returns the largest number 
in a range, that meets a 
single or multiple criteria. 

MAXIFS(max_range, criteria_range1, 
criteria1, [criteria_range2, criteria2], ...) 

 - MINIFS : This function is 
similar to MAXIFS, but it 
returns the smallest 
number in a range, that 

MINIFS(min_range, criteria_range1, 
criteria1, [criteria_range2, criteria2], ...) 
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New Feature Detail Example 
meets a single or multiple 
criteria. 

 
 
 

 - SWITCH : This function 
evaluates an expression 
against a list of values in 
order, and returns the first 
matching result. If no 
results match, the "else" is 
returned. 

=SWITCH(Value to switch, Value to 
match1...[2-126], Value to return if 
there's a match1...[2-126], Value to 
return if there's no match) 

 - TEXTJOIN : This function 
combines text from 
multiple ranges, and each 
item is separated by a 
delimiter that you specify. 
 

TEXTJOIN(delimiter, ignore_empty, 
text1, [text2], …) 

NEW CHARTS - Map charts 
You can create a map chart 
to compare values and show 
categories across 
geographical regions. Use it 
when you have geographical 
regions in your data, like 
countries/regions, states, 
counties or postal codes. 
- Transform geographic data 

into professional 
visualizations 

- Insert > Recommended Charts/Maps   
 

 

 

 

- Funnel charts 
Funnel charts show values 
across multiple stages in a 
process. For example, you 
could use a funnel chart to 
show the number of sales 

- Insert > Funnel Charts   
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New Feature Detail Example 
prospects at each stage in a 
sales pipeline. Typically, the 
values decrease gradually, 
allowing the bars to resemble 
a funnel. 
 

ENHANCED 
VISUALS 

- Scalable Vector Graphics 
(SVG) 

- Bring visual interest to 
your documents, 
worksheets, and 
presentations by 
inserting Scalable 
Vector Graphics (SVG) 
that have filters 
applied to them. 

- Insert >  illustrator 
 

 

 - Convert SVG icons to 
shapes 

- Transform all SVG 
pictures and icons 
into Office shapes so 
you can change their 
color, size, or texture. 

 
 
 
 
 
 
 
 
 
 

- Format > Convert to Shape 
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New Feature Detail Example 
 - Insert 3D models to see 

all the angles 
- Use 3D to increase 

the visual and 
creative impact of 
your workbooks. 
Easily insert a 3D 
model, then you can 
rotate it through 360 
degrees. 

- Insert >  illustrator > 3D Models 
 

 
 

INK 
IMPROVEMENTS 

- New ink effects 
Express your ideas with flair 
using metallic pens and ink 
effects like rainbow, galaxy, 
lava, ocean, gold, silver, and 
more. 

- Insert Draw Ribbon 
 

 
 

 - Digital Pencil 
Write or sketch out ideas 
with our new pencil texture. 

 

 - Customizable, portable 
pen set 

Create a personal set of pens 
to suit your needs. Office 
remembers your pen set in 
Word, Excel, and PowerPoint 
across all your Windows 
devices. 
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New Feature Detail Example 
 - Ink equations 

Including math equations has 
gotten much easier. Now, you 
can go to Insert > Equation > 
Ink Equation, any time you 
want to include a complex 
math equation in your 
workbook. If you have a touch 
device, you can use your 
finger or a touch stylus to 
write math equations by 
hand, and Excel will convert 
it to text. (If you don't have a 
touch device, you can use a 
mouse to write, too). You can 
also erase, select, and correct 
what you've written as you 
go. 

 
 

 

BETTER 
ACCESSIBILITY 
FEATURES 

- One-click fixes for 
accessibility issues 

The Accessibility Checker is 
better than ever with 
updated support for 
international standards, and 
handy recommendations to 
make your documents more 
accessible. 

- Review > Check Accessibility Icon 
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New Feature Detail Example 
SHARING IS 
EASIER 

- Insert recent links 
Easily attach hyperlinks to 
recent cloud-based files or 
websites, and create 
meaningful display names for 
people using screen readers. 
To add a link to a recently 
used file, on the Insert tab, 
choose Link and select any 
file from the displayed list. 

- Insert > Link 

  
 

 - View and restore changes 
in workbooks that are 
shared 

Quickly view who has made 
changes in workbooks that 
are shared, and easily restore 
earlier versions. For more 
information, see View 
historical versions of Office 
files. 

 

 

 - Quickly save to recent 
folders 

This feature was highly 
requested by our customers: 
Go to File > Save As > 
Recent, and you’ll see a list 
of recently accessed folders 
that you can save to. 
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New Feature Detail Example 
GENERAL 
IMPROVEMENTS 

- Precision selecting 
Ever selected too many cells 
or the wrong ones? You can 
now deselect extraneous 
cells without having to start 
over. 

 

 
 - Quick access to superscript and subscript 

Keep the superscript and subscript commands at your fingertips by adding 
them to the Ribbon or Quick Access Toolbar. 

 - Improved autocomplete 
Excel autocomplete isn't as picky as it was before. For example, let's say 
you want to use the NETWORKDAYS function, but you can't remember 
how it is spelled. If you just type =DAYS, the autocomplete menu will 
bring back all of the functions that contain "DAYS," including, 
NETWORKDAYS. Before, you had to spell the function name exactly. 

 - New Themes 
There are now three Office Themes that you can apply: Colorful, Dark 
Gray, and White. To access these themes, go to File >Options > General, 
and then click the drop-down menu next to Office Theme. 

 - Black Theme 
The highest-contrast Office theme yet has arrived. To change your Office 
theme, go to File > Account, and then click the drop-down menu next to 
Office Theme. The theme you choose will be applied across all your 
Office apps. To learn more about Office themes, see Change the look and 
feel of Office for Windows with Office themes. 

 - Break the language barrier 
Translate words, phrases, or sentences to another language with Microsoft 
Translator. You can do this from the Review tab in the ribbon. 

 - No warnings when saving a CSV file 
Remember this warning? "This file may contain features that are not 
compatible with CSV..." Well, you asked for it! We will no longer show this 
when saving a CSV file. 
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New Feature Detail Example 
 - CSV (UTF-8) support 

You asked for it on our Excel User Voice forum: You can now open and 
save CSV files that use UTF-8 character encoding. Go to File > Save As > 
Browse. Then click the Save as type menu, and you'll find the new option 
for CSV UTF-8 (Comma delimited). CSV UTF-8 is a commonly used file 
format that supports more characters than Excel’s existing CSV option 
(ANSI). What does this mean? Better support for working with non-English 
data, and ease of moving data to other applications. 

 - Data Loss Protection (DLP) in Excel 
Data Loss Protection (DLP) is a high-value enterprise feature that is well 
loved in Outlook. We are introducing DLP in Excel to enable real time 
scan of content based on a set of predefined policies for the most 
common sensitive data types (e.g., credit card number, social security 
number, and US bank account number). This capability will also enable 
the synchronization of DLP policies from Office 365 in Excel, Word, and 
PowerPoint, and provide organizations with unified policies across content 
stored in Exchange, SharePoint and OneDrive for Business. 

PIVOTTABLE 
ENHANCEMENTS 

- PivotTable enhancements 
Excel is known for its flexible and powerful analysis experiences, through 
the familiar PivotTable authoring environment. With Excel 2010 and Excel 
2013, this experience was significantly enhanced with the introduction of 
Power Pivot and the Data Model, bringing the ability to easily build 
sophisticated models across your data, augment them with measures and 
KPIs, and then calculate over millions of rows with high speed. Here are 
some of the enhancements we made, so that you can focus less on 
managing your data and more on uncovering the insights that matter. 

POWER PIVOT 
UPDATES 

- Save relationship diagram view as picture   
- Enhanced Edit Relationship dialog creates faster and more accurate data 

relationships    
- Table selection using keyboard navigation    
- Column selection using column navigation    
- Auto column suggestion for same column name in both tables 
Fixes that improve your overall modeling user experience   
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New Feature Detail Example 
PUBLISH TO 
POWER BI 

If you have a Power BI subscription, you can now publish files that are 
stored locally to Power BI. To get started, first save your file to your 
computer. Then click File > Publish > Publish to Power BI. After you 
upload, you can click the Go To Power BI button to see the file in your 
web browser. 

GET & 
TRANSFORM 
(POWER QUERY) 

- This section contains 
improvements made to 
Get & Transform (also 
known as Power Query). 

- New and improved 
connectors 

- Improved transformations 
- General improvements 

 

 
 

 

 

 

 

 

 =IFS($D2>=4,"ดีมาก",$D2>=3.5,"ด"ี,$D2>=3,"ปานกลาง",TRUE,"

ปรับปรุง") 
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File formats that are supported in Microsoft Office 2019 

Application Extension Description 

Word .docx Word 2010 XML Document 

 .docm Word 2010 XML Macro-Enabled Document 

 .dotx Word 2010 XML Template 

 .dotm Word 2010 XML Macro-Enabled Template 

Excel .xlsx Excel 2019 XML Workbook 

 .xlsm Excel 2019 XML Macro-Enabled Workbook 

 . xltx Excel 2019 XML Template 

 .xltm Excel 2019 XML Macro-Enabled Template 

 .xlsb Excel 2019 binary workbook (BIFF12) 

 . xlam Excel 2019 XML Macro-Enabled Add-In 

Office 2019 applications now save files with new, different file extensions 

Application Extension Description 

PowerPoint .pptx PowerPoint 2010 XML Presentation 

 .pptm PowerPoint 2010 Macro-Enabled XML Presentation 

 . potm PowerPoint 2010 Macro-Enabled XML Template 

 . ppam PowerPoint 2010 Macro-Enabled XML Add-In 

 . ppsx PowerPoint 2010 XML Show 

Access . ACCDB The file extension for the new Office Access 2010 file 
format. This takes the place of the MDB file extension. 

 . ACCDE The file extension for Office Access 2010 files that are 
in "execute only"  mode.  ACCDE files have all Visual 
Basic for Applications (VBA) source code hidden. A user 
of an ACCDE file can only execute VBA code, but not 
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File formats that are supported in Microsoft Office 2019 

Application Extension Description 

view or modify it.  ACCDE takes the place of the MDE 
file extension. 

 . ACCDT The file extension for Access Database Templates. 

 . ACCDR A new file extension that enables you to open a 
database in runtime mode.  By simply changing a 
database's file extension from . accdb to . accdr, you 
can create a " locked- down"  version of your Office 
Access 2010 database.  You can change the file 
extension back to .accdb to restore full functionality. 

 .sldx  Slide 

 .sldm  Macro-enabled slide 

 .thmx Office theme 
 

 Feature in Microsoft Office Excel 2019 

 

ส่วนที่เพิ่ม คำอธิบาย 

  
ส่วนติดต่อผู้ใช้ 
(User Interface) 

ออกแบบให้ผู้ใช้สามารถค้นหา และเข้าถึงคำสั่งที่ต้องการได้อย่างรวดเร็วมายิ่งขี้น 
โดยออกแบบในรูปของแท็บที่รวบรวมคำสั่งไว้เป็นหมวดหมู่ เครื่องมือต่างๆ จะมี
คำอธิบายที่ชัดเจนยิ่งขึ้น ได้เพ่ิมเมนู File และคำสั่งอ่ืนเพิ่มเติม 

Row & Column จำนวนแถว 1,048,576 แถว จำนวนคอลัมน์ 16,384 คอลัมน์ (A – XFD) 

Live Preview แสดงผลลัพธ์ของคุณสมบัติที่เลือกให้กับวัตถุได้ทันทีเพ่ือความสะดวกรวดเร็วในการ
ออกแบบ 

Gallery ออกแบบเพื ่อช่วยในการปรับแต่งรูปแบบของข้อมูล หรือเซลเพ่ือให้สามารถ
ปรับแต่งรูปแบบที่ซับซ้อนได้ง่ายขึ้นในขั้นตอนเดียว รวมถึงการออกแบบรูปแบบ
ของ Gallery ได้เองเพ่ือใหตรงกับความต้องการของผู้ใช้มากที่สุด เช่น Cell Styles  
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ส่วนที่เพิ่ม คำอธิบาย 

Argument in function จำนวน Argument ที่ Funtion สามารถนำไปใช้ได้ถูกเพิ่มให้ใช้ได้สูงสุด 30 เป็น 
256 ค่า ทำให้สามารถรองรับสนับสนุนการทำงานของ Function ที่ซับซ้อนได้เป็น
อย่างดี 

Status Bar จำนวนผลคำนวณที่แสดงบน Status Bar นั้นสามารถแสดงพร้อมกันได้ถึง 6 ค่า 
คือ Average , Count , Numerical Count , Min , Max และ Sum อำนวยความ
สะดวกกว่าเวอร์ชั่นก่อนหน้านี้ที่แสดงเพียง 1 ค่าเท่านั้น 

Trendline เป็นเส้นแสดงแนวโน้มของข้อมูล มีไว้เพื ่อช่วยในการวิเคราะห์แนวโน้มของ
แผนภาพว่าในอนาคตข้อมูลจะเป็นไปในทิศทางใดเพื่อช่วยให้วางแผนในอนาคตได้
ง่ายยิ่งขึ้น 
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 หน้าจอของโปรแกรม Microsoft Office Excel 2019  

 
 

หน้าจอของโปรแกรม Microsoft Office Excel 2019 ได้รับการพัฒนาให้มีความแตกต่างกับ Microsoft Excel 
2007 โดยจะแสดงคำสั่งต่างๆ บนริบบอน (Ribbon) ซึ่งจะอำนวยความสะดวกให้ผู้ใช้งานสามารถใช้คำสั่งต่างๆ ได้
อย่างสะดวก โดยคำสั่งต่างๆ จะแสดงอยู่บน Ribbon โดยแยกหมวดหมู่ของคำสั่งอยู่บนแท็บ (Tab) 
 

 

 

 

 

 

Maximize/Restore button. 
Application close 

button. 

Quick Access tool bar 

Office Button 

Work Sheet 
Page View Buttons Zoom Control 

Workbook 

Row 

Column 

Cell 
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 หน้าจอของโปรแกรม Microsoft Office Excel 365 

 
 

 
 
 
 

 

https://outlook.live.com/ 

Microsoft Office 365 
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 ริบบอน (Ribbon)  คืออะไร 

 

 ได้นำคำสั่งต่างๆ ที่นิยมใช้มากที่สุดมาไว้ในส่วนหน้าสุด
โดยที่คุณไม่จำเป็นต้องเข้าไปค้นหาสิ่งที่คุณใช้เป็นประจำ
ในส่วนต่างๆ ของโปรแกรม สาเหตุใดจึงต้องมีการ

เปลี่ยนแปลง เหตุผลก็คือเพ่ือให้คุณสามารถทำงานได้ง่ายและรวดเร็วยิ่งขึ้น โดยได้มีการวิจัยและออกแบบ Ribbon 
อย่างละเอียดจากประสบการณ์ของผู้ใช้ เพื่อให้คำสั่งต่างๆ อยู่ในตำแหน่งที่ดีที่สุด เพื่อช่วยให้คุณเรียนรู้เกี่ยวกับ
วิธีการใช้ Ribbon ได้ดียิ่งขึ้น โดย Ribbon ประกอบด้วยองค์ประกอบพื้นฐานดังนี้ 

 
1. แท็บ Ribbon (Ribbon Tab) : ประกอบไปด้วยแท็บต่างๆ หลายแท็บ ในที่นี้ ได้แสดงให้เห็นแท็บ 

ข้อความ แต่ละแท็บจะสอดคล้องกับการทำงานแต่ละชนิดที่คุณทำงาน บนแท็บจะมีคำสั่งและปุ่มที่คุณ
เคยใช้ก่อนหน้านี้ 

2. กลุ่ม (Group) : แต่ละแท็บจะมีกลุ่มหลายกลุ่มซึ่งจะแสดงรายการที่สอดคล้องกันไว้ด้วยกัน ข้อความ
พ้ืนฐาน คือกลุ่มๆ หนึ่ง 

3.  คำสั่ง (Commands) : ปุ่มตัวหน้า และรายการแบบอักษร (แสดงแบบอักษร Tahoma ) คือคำสั่ง โดย
คำสั่งอาจจะเป็นปุ่ม กล่องเพ่ือใส่ข้อมูล หรือเมนูก็ได้ คำสั่งที่มีการใช้งานทั่วไปมากที่สุด อย่างเช่น คำสั่ง
วาง (Paste) จะเป็นปุ่มทีมี่ขนาดใหญ่สุด 

Ribbon 
1 

2 3 
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 แท็บของ  Microsoft Office Excel 2019  

 

แท็บของโปรแกรม MS Excel 2019 จะแยกกลุ่มของริบบอนตามฟังก์ชันและการทำงานของโปรแกรม หากผู้ใช้
ต้องการแทรกวัตถุ หรือรูปภาพลงในเอกสาร ต้องคลิกแท็บ Insert ริบบอนที่เกี่ยวข้องกับการแทรกวัตถุหรือรูปภาพจึงจะ
แสดงขึน้มาหรือในกรณขีองการจัดหน้าเอกสารก็ต้องคลิกแท็บ Page Layout เป็นต้น 
 
แท็บ File : กลุ่มของคำสั่งที่เกี่ยวของกับการจัดไฟล์ การแสดงรายละเอียดของไฟล์ เป็นต้น 
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แท็บ Home : กลุ่มของคำสั่งที่เกี่ยวของกับการจัดรูปแบบข้อความ Font   ตำแหน่งข้อความภายใน Cell เป็นต้น 

 

แท็บ Insert : กลุ่มของคำสั่งเกี่ยวกับการเพ่ิมตาราง รูปภาพ ตัวอักษรประดิษฐ์ กราฟ สัญลักษณ์พิเศษ เป็นต้น 

 

แท็บ Page Layout : กลุ่มของคำสั่งเกี่ยวกับการจัดขนาดของกระดาษ การวางแนวเอกสาร ใส่สีพ้ืนหลัง เป็นต้น 

 

แท็บ Formulas : กลุ่มของคำสั่งเกี่ยวกับการใส่สูตรคำนวณ และเรียกใช้ฟังก์ชั่นต่างๆ ที่โปรแกรมจัดเตรียมไว้ให้ 

 

แท็บ Data : กลุ่มของคำสั่งเกี่ยวกับการจัดการด้านข้อมูล เช่น การนำเข้าข้อมูล การเรียงลำดับ การกรอกข้อมูล เป็นต้น 
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แท็บ Review : กลุ่มของคำสั่งเกี่ยวกับการตรวจสอบการสะกด ไวยกรณ์ สร้างหมายเหตุ การป้องกันข้อมูลของแผ่น
งาน การทำงานร่วมกัน เป็นต้น 

 

 

แท็บ View : กลุ่มของคำสั่งเกี่ยวกับการจัดมุมมองการทำงานของเอกสาร เช่น การย่อ-ขยาย การแสดงGridline) เป็นตน้ 

 

 

แท็บ Developer : กลุ่มของคำสั่งในการจัดทำ Marco เพ่ือใช้งานในขั้นที่สูงขึ้น 

 

แท็บ Draw : กลุ่มของชุดคำสั่งใหม่ที่เพ่ิมความสะดวกในการจัดทำเอกสารที่เน้นการจัดงาน Graphic 
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การตั้ งค่าใช้งานบนโปรแกรม  Microsoft Excel  เพิ่มเติม (Excel Option ) 
 
 โปรแกรม Microsoft Office ตั้งแต่เวอร์ชั่น 2007 เป็นต้นมาการตั้งค่า
ต่างๆ เพิ่มเติมสามารถเลือกได้โดยไปท่ีปุ่ม Options เช่น การซ่อน - แสดง Tab 
ต่างๆ กำหนดการกรอกข้อมูลอัตโนมัติ (Auto Fill) เป็นต้น โดยใช้คำสั่งไปที่ปุ่ม 
More > Options 
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หน้าต่างสำหรับแสดงคุณสมบัติ เพิ่มเติม  (Dialog Box Launchers )  
 

หน้าต่างสำหรับแสดงคุณสมบัติเพิ่มเติม หากกลุ่มคำสั่ง (Group)  บนแท็บมีสัญลักษณ์    แสดงว่า
กลุ่มคำสั่งนั้นสามารถกำหนดคุณสมบัติเพิ่มเติมได้ เช่น กลุ่มคำสั่ง Font , Paragraph เป็นต้น 
 

 
 

 

 

 

 

 

 

การแสดงแท็บช่วยเหลือเพิ่มเติม (Additional Tabs) 
 

สำหรับคำสั ่งใน Microsoft Excel 2019 จะแสดงบนแท็บ  แท็บช่วยเหลือจะปรากฏโดยอัตโนมัต ิเมื่อ
สถานะการทำงานปัจจุบันของวัตถุนั้นถูกเลือก เช่น แท็บ Picture Tools จะปรากฏเมื่อคลิกที่รูป เป็นต้น ตัวอย่างดังนี้  
 

 

1. คลิกบนรูปที่ต้องการแก้ไข/ตบแต่ง 
2. แท็บ Picture Tools จะปรากฏโดยอัตโนมัติ 
3. กลุ่ม (Groups) คำสั่งต่างๆ ที่เกี่ยวข้องจะปรากฏให้เลือกใช้คำสั่งที่เกี่ยวข้องกับ เช่น Picture Styles  

 

1 

2 

     เมื ่อคลิกออกนอกรูปแท็บ Picture Tool จะหายไปโดย
อัตโนมัติ และหากคลิกที่รูปอีกครั้ง Picture Tools จะปรากฏ
อีกครั้ง ดังภาพข้างต้น 
     Note: On-demand tabs appear for other activity 
areas, like tables, drawings, diagrams, and charts.  
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 เมนูของ  Microsoft Office Excel 2019  

 

1. ปุ่ม   File จะแสดงอยู่ที่มุมซ้ายสุดของหน้าต่างโปรแกรมใช้สำหรับเปิดเมนูการใช้งาน
พ้ืนฐาน เช่น คำสั่ง New/ Open/ Save/ Save As/ Print และอ่ืนๆ รวมถึงคำสั่งที่ใช้ปรับแต่งการทำงาน
พ้ืนฐานของโปรแกรม More > Excel Options เป็นต้น 

 

 
 
 
 
 

Excel Options 
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2. คำสั่งหลักในปุ่ม Microsoft Office มีดังนี้ 

คำสั่ง หน้าที่การทำงาน คำส่ัง หน้าที่การทำงาน 
Save บันทึกเอกสาร Print สั่งพิมพ์เอกสาร และดูเอกสารก่อนพิมพ์ 

(Print Preview)  
Save As บันทึกเอกสารที่เคยบันทึกแล้วเก็บ

ไว้ในชื่อใหม่หรือรูปแบบเอกสารใหม่ 
Send & Save ส่งเอกสารไปทางอีเมลหรือแฟกซ์ 

Open เปิดเอกสารเก่าท่ีมีอยู่ Add-Ins รายการโปรแกรม/ฟังก์ชั่นการใช้งาน
เพ่ิมเติม 

Close ปิดเอกสาร Help รายการความช่วยเหลือที่ MS Word จัดไว้ 
Info แสดงรายละเอียดเกี่ยวกับไฟล์ Options กำหนดค่าพื้นฐานเบื้องต้นสำหรับการทำงานตา่งๆ  

ภายในโปรแกรม 
Recent แสดงชื่อไฟล์ที่เปิดใช้งานสร้าง Exit ปิดโปรแกรม 
New เอกสารใหม่   

 

 การสร้างไฟล์เอกสาร (Workbook ) 
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 การบันทึกเอกสาร  (Save Workbook ) 
 

การบันทึกเอกสาร (Save) 

Save : บ ันท ึก Workbook ทับไฟล ์ เด ิม แต ่หากเป็น 
Workbook ท ี ่ ย ั ง ไม ่ เคยถ ู กบ ั นท ึ ก  จะปรากฏ
ไดอะล็อกบ๊อกซ์ Save As  
Save As  : บันทึก Workbook เป็นชื่อไฟล์ใหม่ หรือ
เปลี่ยนประเภทของไฟล์   
▪ Excel Workbook (xlsx)  :  ไฟล ์  MS Excel 

2019 
▪ Excel Macro-Enabled Workbook (xlsm) : 

ไฟล์ Workbook นี้สามารถใช้งาน Macro ได ้
▪ Excel 97-2007 Workbook (xls) : ไฟล ์ MS 

Excel 97-2007 
▪ รูปแบบไฟล์อื ่นๆ เช่น *.txt , *.csv , *.htm ,  

*.xml , *.prn  เป็นต้น 
(*.xltx ไฟล์ Template)  
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Workshop :  การตั้ งรหัสผ่านให้กับไฟล์ข้อมูล  (Protect Workbook) ผ่านเมนู  Info    
 
 ในการรักษาความปลอดภัยในการเข้าถึงข้อมูลภายในไฟล์ เราสามารถตั้งรหัสผ่านในการเปิดไฟล์เพ่ือ
ป้องกันไมใ่ห้ผู้ไม่มีสิทธิ์เข้ามาเปิดใช้งาน มีข้ันตอนดังนี้  
 

วิธีที่ 1  

1. File >> Info >> Encrypt With Password : วิธีนี้เป็นการตั้งรหัสผ่านในการเปิดไฟล์ 

a 
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Workshop :  การตั้ งรหัสผ่านให้กับไฟล์ข้อมูล  (Protect Workbook) ผ่านเมนู  Save As    
 
วิธีที่ 2 

1. Office Button >> Save As : วิธีนี้เป็นการตั้งรหัสผ่านในการเปิดไฟล์หรือแก้ไขไฟล์ 
2. เลือกชนิดไฟล์ 
3. คลิกปุ่ม Tools >> General Option 
4. ตั้งรหัสผ่านในการเปิดไฟล์หรือแก้ไขไฟล์ 

 

 
 

 

3 

5 
4 
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Workshop :  การตั้ งรหัสผ่านในการใช้งาน  WorkSheet  
 

  

 

Workshop  :  การตั้ งรหัสผ่านในการใช้งาน  Cell  
 

 

 

 

 

 

 

 

 

 

ใส่รหัสผ่าน และเลือก
สิ่งที่ต้องการให้ผู้ใช้
จัดการกับไฟล์ได้ 
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 การเปิดไฟล์เอกสาร (Open Workbook ) 
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 การเปิดไฟล์เอกสาร (Open Workbook ) 
 

 

 

 

 

 

 

 

 

 

 

 ลักษณะของตัวชี้ เมาส์ (Mouse Pointer ) 

 

ouse Pointer ใน Microsoft Excel 2019 มีหลายแบบซึ่งจะเปลี่ยนไปตามลักษณะการใช้งานและการ
วางตำแหน่งของ Mouse มีดังนี ้

ลักษณะ Mouse คำอธิบาย รูป 

Normal Pointer ลักษณะของตัวชี้ตำแหน่งเมาส์ที่ใช้ในการทำงานทั่วไป เช่น การเลือกเมนู 
คำสั่ง การย้ายหน้าต่าง การเลื่อน Scroll Bar เป็นต้น (พร้อมทำงาน)  

Normal Pointer in 
Worksheet 

ลักษณะของตัวชี้ตำแหน่งเมาส์แสดงให้ทราบว่า Mouse Pointer วางอยู่บน 
Space Sheet (พร้อมที่จะเลือก)  

I-Bean Pointer ลักษณะของตัวชี้ตำแหน่งเมาส์นี้แสดงว่าบริเวณที่ Mouse วางอยู่สามารถ
พิมพ์ตัวอักษรได้  

Move Pointer ลักษณะของตัวชี้ตำแหน่งเมาส์นี้แสดงว่าบริเวณที่ Mouse วางอยู่สามารถ
เคลื่อนย้าย Cell ได ้

 

Row Width Adjuster 
และ Column Width 
Adjuster 

ใช้ในการปรับขนาดของ Row และ Column  

M 
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 การเลือกเซล  

▪ เลือกเซลเดียว : ใช้ Mouse คลิกท่ีเซลที่ต้องการ หรือใช้ Arrow Key เลื่อนไปยังตำแหน่งที่ต้องการ 
▪ เลือกกลุ่มของเซลท่ีต่อเนื่อง :  

▪ ใช้ Mouse คลิกที ่เซลเริ ่มต้น และลาก
เมาส์เพื่อคลุมถึงเซลสุดท้าย หรือ 

▪ ใช้ Mouse คลิกเซลเริ่มต้นจากนั้นกดปุ่ม 
Shift ค้างไว้และคลิกที่ตำแหน่งสุดท้าย 

▪ เลือกกลุ่มของเซลที่ไม่ต่อเนื่อง : คลิกเซลแรก กด
ปุ่ม Ctrl ค้างไว้ และเลือกเซลที่ต้องการ 

 รูปแบบข้อมูล (Format Cells ) 

 

▪ ข้อมูลประเภทข้อความ (Text) : ข้อมูลที่ไม่
นำมาคำนวณ อาจเป ็นต ัวอ ักษร  ต ัวเลข 
เครื่องหมาย การใส่ข้อมูลที่มีความยาวมากกว่า
ความกว้างของเซลล์ข้อความนั้นจะถูกแสดง
ต่อไปในเซลล์ที่อยู่ทางขวามือ ตราบใดที่เซลล์
ทางขวามือนั้นยังไม่มีข้อมูล ข้อมูลชนิดนี้จะถูก
จัดให้อยู่ชิดซ้ายของเซลล์เสมอ 

▪ ข้อมูลประเภทตัวเลข (Numeric) : ข้อมูลที่
นำมาคำนวณได้ ข้อมูลจะอยู่ชิดขวา  และไม่
สามารถแสดงผลเกินความกว้างของเซลล์ได้ ถ้า
ค ว ามกว ้ า ง ขอ ง เซลล ์ ไ ม ่ พอจะปรากฏ
เครื ่องหมาย ####### การแก้ไขโดยขยาย
ความกว ้างของเซลล ์ออกไป ถ ้ าต ั วเลขมี
เครื่องหมาย % จะถูกหารด้วย 100  สามารถ
พิมพ์ข้อมลูในรูป Exponential เช่น 2.4E+04 (คือ 2.5 x 104) 

▪ ข้อมูลประเภทวันที ่(Date) : ข้อมูลที่ประกอบด้วยวันที่และเดือน เดือนและป ีหรือวันที่ เดือนและป ีโดย
เดือนสามารถกำหนดได้ทั้งแบบตัวเลข หรือตัวอักษร ข้อมูลชนิดนี้นำไปคำนวณได ้
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ข้อมูลประเภทวันที่ (Date) จะแสดงในรูปแบบวันที่สากล คือ ปี ค.ศ. จึงควรพิมพ์ทั้งวัน/เดือน/ปีค.ศ.
เลข 4 หลักเต็มเสมอ ดังนั้นหากต้องการใส่ข้อมูลประเภทเป็น พ.ศ. จึงควรพิมพ์รูปแบบวันที่สากล (ค.ศ.) 
และจึงเปลี่ยน Format Cells แสดงรูปแบบเซลตามที่ต้องการ เช่นพิมพ์ 16/05/2555 จะหมายถึงวันที่ 16 
เดือนพฤษภาคม ปี 2555 แต่ถ้าใส่ 16/05/55 จะหมายถึงวันที่ 16 เดือนพฤษภาคม ปี ค.ศ. 1955 แทน 

▪ ข้อมูลประเภทเวลา (Time) : ข้อมูลเวลาที่ประกอบด้วยชั่วโมง นาที และวินาที โดยมีเครื่องหมาย : 
ข้อมูลชนิดนี้สามารถนำไปคำนวณได้ ที่แสดงที่ Formular Bar จะเห็นเวลาในรูปแบบที่แสดง AM และ PM 

▪ ข้อมูลประเภทสูตร (Formular) : ข้อมูลประเภทนี้คือสมการคณิตศาสตร์ จะต้องใช้เครื่องหมายเท่ากับ 
(=) นำหน้าสูตรหรือฟังก์ชัน 
 

 

 

 การจัดการ Worksheet 

 

 ในโปรแกรม Microsoft Office Excel 2019 เมื่อสร้าง Workbook ใหม่จะมี Worksheet เริ่มต้นให้ใช้
งานจำนวน 3 Worksheet โดยผู้ใช้สามารถจัดการเกี่ยวกับ Worksheet เช่น เพ่ิม ลบ เปลี่ยนชื่อ เป็นต้น 

การเพิ่ม Worksheet (Insert) การลบ Worksheet (Delete) 
 

 

 

 
 

 

 

 

 



 

 

 

39 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิศ
ทก

. ก
ลุ่ม

พฒั
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อ์แ
ละ

เค
รือ

ข่า
ย 

[M
icr

os
of

 O
ffi

ce
 E

xc
e 

Ad
va

nc
ed

 l 
20

19
] –

 ว
รา

ภร
ณ

 ์ไต
รศ

ักด
ิ์ศร

ี  

 

การเปลี่ยนชื่อ Worksheet (Rename) การเปลี่ยนสี Worksheet 

 

 

 

การย้าย/คัดลอก Worksheet (Move or Copy) การลบ Worksheet (Delete) 

  

การซ่อน/ Unhide Worksheet (Hide/ Unhide) การตรึง Worksheet (Freeze Panes) 
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 คำสั่งบนแท็บ  Home  

 โปรแกรม Microsoft Office ตั้งแต่เวอร์ชั ่น Excel 2007 - 2019 มีเครื ่องมือที ่สนับสนุนการกำหนด
รูปแบบเซล และข้อมูลให้ตรงกับความต้องการของงานแต่ละงานได้เป็นอย่างดี การกำหนดรูปแบบของเซล และ
ข้อมูลที่ดีนั้นจะทำให้เอกสารที่ได้มีความถูกต้อง สวยงาม ง่ายต่อการใช้งาน 

 ส่วนใหญ่แล้วเครื่องมือต่างๆ ใน Microsoft Office Excel 2019 นั้นมีการทำงานเหมือนเวอร์ชั่นก่อนหน้า
นี้เพียงแต่ถูกกำหนดในส่วนติดต่อกับผู้ใช้ใหม่ เพ่ือให้สามารถเข้าถึงเครื่องมือต่างๆ ได้สะดวกและรวดเร็วมากยิ่งขึ้น 
โดยได้รวบรวมเครื่องมือที่สำคัญในการจัดรูปแบบข้อมูลไว้ที่แท็บ Home ซ่ึงแต่ละกลุ่มเคร่ืองมือมีรายละเอียดดังนี้ 

 

กลุ่มคำสั่ง คำอธิบาย 
Font จัดการเกี่ยวกับการกำหนดแบบ ขนาด ลักษณะ สี พ้ืนหลังของตัวอักษร และเซล 
Alignment กลุ่มคำสั่งจัดการเกี่ยวกับตำแหน่งของตัวอักษร หรือข้อความในเซล 
Number  กลุ่มคำสั่งจัดการเกี่ยวกับการแสดงผลของตัวเลข 
Style กลุ่มคำสั่งจัดการรูปแบบเซลอัตโนมัติ รูปแบบตาราง รูปแบบการแสดงผลตามเงื่อนไข 
Cell กลุ่มคำสั่งจัดการรูปแบบของเซล ขนาดแถว-คอลัมน์ การเพ่ิม-ลบเซล  
Editing กลุ่มคำสั่งจัดการข้อมูลใน Worksheet เช่น ใส่สูตรอย่างง่าย กรอก หรือค้นหาข้อมูล 
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Workshop  :  การตบแต่ง Worksheet อัตโนมัติด้วย Format as Table  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

  

1 

4.1 

3 

2 

4.2 

5.1 

    

     ช ่วยเพิ ่มความสะดวกในการตบแต่ง
ข้อมูลภายใน Worksheet เพราะมีรูปแบบ
ของ Tablel Styles ให้เลือกมาก สามารถ
กำหนดกำหนดรูปแบบการแสดงผลของ
ตาราง (Table Style Options) และยังมี
คำส ั ่ ง ในการ Remove ข ้ อม ู ลท ี ่ ซ้ ำ 
(Remove Duplicates) เป็นต้น 
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Workshop :  การกำหนดเงื่อนไขตบแต่งเซลแบบอัตโนมัติ  (Conditional Formatting ) 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.1 

    

 

     เป็นคำสั่งที่ช่วยเพิ่มความสะดวกในการตบ
แต่งข้อมูลและการเลือกแสดงผลข้อมูลภายใน 
Worksheet เพราะมีรูปแบบให้เลือกกำหนด
เงือ่นไขในการจัดรูปแบบของข้อมูลมาก สามารถ
กำหนดกำหนดร ูปแบบการแสดงผลตามที่
ต้องการได้  

1 

2 

3 



 

 

 

43 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิศ
ทก

. ก
ลุ่ม

พฒั
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อ์แ
ละ

เค
รือ

ข่า
ย 

[M
icr

os
of

 O
ffi

ce
 E

xc
e 

Ad
va

nc
ed

 l 
20

19
] –

 ว
รา

ภร
ณ

 ์ไต
รศ

ักด
ิ์ศร

ี  

Workshop :  การจัดรูปแบบเซล  
 

 

 

Merge Cells 

1 
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2.2 

5 

3.1 

3.2 

4 
2.1 
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การจัดรูปแบบเซลแบบกำหนดเอง  (Custom ) 
 
 

ustom Excel number format : Microsoft Excel has a lot of built-in formats for number,
เ currency, percentage, accounting, dates and times. But there are situations when you 
need something very specific.  If none of the inbuilt Excel formats meets your needs, 

you can create your own number format.  
Number 

formatting in Excel 
is a very powerful 
tool, and once 
you learn how to 
use it property, 
your options are 
almost unlimited. 
The aim of this 
tutorial is to 
explain the most 
essential aspects 
of Excel number 
format and set 
you on the right 
track to mastering 
custom number 
formatting. 

 
 

Ref: https://www.ablebits.com/office-addins-blog/2016/07/07/custom-excel-number-format/ 

C 
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Understanding Excel number format 

To be able to create a custom format in Excel, it is important that you understand how 
Microsoft Excel sees the number format. 

An Excel number format consists of 4 sections of code, separated by semicolons, in this order: 

POSITIVE; NEGATIVE; ZERO; TEXT 

 

1. Format for positive numbers (display 2 decimal places and a thousands separator). 
2. Format for negative numbers (the same as for positive numbers, but enclosed in 

parenthesis). 
3. Format for zeros (display dashes instead of zeros). 
4. Format for text values (display text in magenta font color). 

 
Digit and text placeholders 

For starters, let's learn 4 basic placeholders that you can use in your custom Excel format. 

Code Description Example 

0 Digit placeholder that displays insignificant zeros.  
การใส่ตัวเลข โดยเลข 0 จะถูกแสดงออกมาแม้ไม่จำเป็น  

#.00 - always displays 2 
decimal places. 
If you type 5.5 in a cell, it will 
display as 5.50 
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Code Description Example 

# Digit placeholder that represents optional digits and 
does not display extra zeros. 
That is, if a number doesn't need a certain digit, it 
won't be displayed. 
การใส่ตัวเลข โดยเลข 0 จะถูกตัดท้ิงหากไม่มีค่า 

#.## - displays up to 2 
decimal places. 
If you type 5.5 in a cell, it will 
display as 5.5 
If you type 5.555, it will 
display as 5.56. 

? Digit placeholder that leaves a space for 
insignificant zeros on either side of the decimal 
point but doesn't display them. It is often used to 
align numbers in a column by decimal point. 
การใส่ตัวเลข โดยเลข 0 จะถูกแทนด้วยช่องว่างหากไม่มีค่า 

#.??? - displays a maximum of 
3 decimal places and aligns 
numbers in a column by 
decimal point. 

@ Text placeholder 0.00; -0.00; 0; [Red]@ - 
applies the red font color for 
text values. 

 ยกเว้น ตัว $ – + / ( ) : space ไม่ต้องใส่เครื่องหมายคำพูด
ครอบก็ได้ 

 

Below you will find a few more examples that will hopefully shed more light on number 
formatting in Excel. 

Format Description Input values Display as 

#.000 Always display 3 decimal places. 2 
2.5 

0.5556 

2.000 
2.500 
.556 

#.0# Display a minimum of 1 and a maximum of 
2 decimal places. 

2 
2.205 
0.555 

2.0 
2.21 
.56 
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Format Description Input values Display as 

???.??? Display up to 3 decimal places with aligned 
decimals. 

22.55 
2.5 

2222.5555 
0.55 

22.55 
2.5 

2222.556 
.55 

#,##0 "บาท" การใส่ข้อความร่วมกับรูปแบบตัวเลข 2,200 2,200 บาท 

d กำหนดรูปแบบการแสดงผลเป็น วันที่ 1 หลัก 9/8/2019 9 

dd กำหนดรูปแบบการแสดงผลเป็น วันที่ 2 หลัก 9/8/2019 09 

ddd กำหนดรูปแบบการแสดงผลเป็น วัน แบบสั้น 9/8/2019 Thu 

dddd กำหนดรูปแบบการแสดงผลเป็น วัน แบบคำเต็ม 9/8/2019 Thursday 

m กำหนดรูปแบบการแสดงผลเป็น เดือน 1 หลัก 9/8/2019 5 

mm กำหนดรูปแบบการแสดงผลเป็น เดือน 2 หลัก 9/8/2019 05 

mmm กำหนดรูปแบบการแสดงผลเป็น เดือน แบบสั้น 9/8/2019 Aug 

mmmm กำหนดรูปแบบการแสดงผลเป็น เดือน แบบคำเต็ม 9/8/2019 August 

mmmmm กำหนดรูปแบบการแสดงผลเป็น เดือน แบบคำเต็ม 9/8/2019 A 

yy กำหนดรูปแบบการแสดงผลเป็น ปี 2 หลัก 9/8/2019 19 

yyyy กำหนดรูปแบบการแสดงผลเป็น ปี 4 หลัก 9/8/2019 2019 

h ชั่วโมง 10:08:38 PM 22 

hh:mm นาที 
* Note:  The m or mm code must appear 
immediately after the h or hh code or 
immediately before the ss code; otherwise, 
Excel displays the month instead of minutes. 

▪ Elapsed time in hours; for example, 
25.02  >> [h]:mm 

10:08:38 PM 
 
 
 
 

=MINUTE(A5) 

10:08 
 
 
 
 

08 

ss วินาที 10:08:38 PM 38 
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Format Description Input values Display as 

 

 [YELLOW] กำหนดสีในการแสดงผล 
http://dmcritchie.mvps.org/excel/colors.htm 
[BLACK], [BLUE], [CYAN], [GREEN], 
[MAGENTA], [RED], [WHITE], [YELLOW], 
[COLOR 1-56] 

[Color23]#,##0 
▲;[Red]#,##0 

▼ 

 

"เหลืออีก" 0 "วัน"; 
"เลยมาแล้ว" 0 

"วัน"; "วันนี้พอดี"; 

กำหนดให้แสดงข้อความเม่ือกำหนดให้เงื่อนไขเป็น
บวก ลบ และศูนย์ (วันที่ 4/5/2019 วันที่ปัจจุบัน
เป็น 9/5/2019) 
[Green] "เหลืออีก" 0 "วัน"; [Red] "เลยมาแล้ว" 0 
"วัน"; [Black] "วันนี้พอดี"; 

=B2 – Today() เลยมาแล้ว 
5 วัน 

 

ตัวอย่างการ Custom Fomat Cell 
ข้อความ Format Cell (Custom) แสดงผล หมายเหตุ หมาย

เหตุ 
1.2 0.00 1.20     
1.2 #.## 1.2     
04-08-19 dd 04  [$-411]ddd 日 
04-08-19 mm 08     
04-08-19 yyyy 2019     
04-08-19 mmm Aug     
04-08-19 mmmm August     
04-08-19 mmmmm A     
12:33:55 hh 12     
25:33:55 
PM 

[hh] 25:33:55 
PM 

    

12:33:55 hh:mm 12:33 =MINUTE($A$
19) 

33 

12:33:55 ss 55     

http://dmcritchie.mvps.org/excel/colors.htm
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ตัวอย่างการ Custom Fomat Cell 
ข้อความ Format Cell (Custom) แสดงผล หมายเหตุ หมาย

เหตุ 
12.23 [$-D07041E]#,##0.00 

MS Office 2019 
๑๒,๓๔๕,๖๗

๐.๒๕ 
[$-D07041E]0 t#,##0_

);(t#,##
0)  

-201 [Red][<-200](-0.00);[Blue][=200](0.00);[Black]0.00 (-201.00) สีแดง   
200 [[Red][<-200](-0.00);[Blue][=200](0.00);[Black]0.00 (200.00) สีน้ำเงิน   
199 [Red][<-200](-0.00);[Blue][=200](0.00);[Black]0.00 199.00 สีดำ   
200 #,##0 "บาท" 200 บาท     
04-05-19 [Green] "เหลืออีก" 0 "วัน"; [Red]"เลยมาแล้ว" 0 "วัน"; 

[Black]"วันนี้พอดี"; 
 เลยมาแล้ว 

5 วัน 
=D18-

TODAY() 
Today 
09-05-

19 

 

 

 

Macro 
Sub ArabicToThai() 
 For i = 0 To 9 
 Cells.Replace What:=Chr(48 + i), Replacement:=Chr(240 + i) 
 Next 
End Sub 
Sub ThaiToarAbic() 
 For i = 0 To 9 
 Cells.Replace What:=Chr(240 + i), Replacement:=Chr(48 + i) 
 Next 
End Sub 
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 เทคนิคการกรอกข้อมูล  
 

 

 
 

 

 

 

 

 

 

 

 

 

    

 

เป็นคำสั่งที่ช่วยเพิ่มความสะดวกในการ
กรอกข้อมูลอัตโนมัติ หากข้อมูลเป็นตัวเลขจะ
สามารถเพิ ่มลำด ับได ้อ ัตโนมัต ิ หร ือพิมพ์
ข้อความอัตโนมัติ โดยใช้วิธ ีการนำ Mouse 
Pointer วางลงมุมขวาล่าง แล้วลาก 

หร ื อปร ั บค ่ าใน Excel Option > 
Advance > Edit Custome Lists 
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Workshop :  เทคนิคการกรอกข้อมูลแบบอัตโนมัติ  (Flash Fill : Excel 2013-2019, 365) 
 

 

 

What is Flash Fill in Excel?  

Excel Flash Fill is a special tool that analyzes the information you are entering and 
automatically fills data when it identifies a pattern. 

The Flash Fill feature was introduced in Excel 2013 and is available in all later versions of 
Excel 2016, Excel 2019, and Excel for Office 365. 

Workshop  :  เทคนิคการกรอกข้อมูลแบบอัตโนมัติ  (Flash Fill) แบบต่างๆ 
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Workshop  :  การควบคุมความถูกต้องของข้อมูลด้วย  Data Validation   
 

โปรแกรม Microsoft Excel 2007 ขึ้นไปมีการเพ่ิมความสามารถในการจัดการกับข้อมูลได้หลากหลายขึ้น 
โดยในการจัดการกับการกรอกข้อมูลด้วย Drop Down List สามารถทำได้โดยใช้คำสั่งบนแท็บ Data > Data 
Validation 
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Workshop  :  เทคนิคจัดการกับข้อมูลที่ซ้ำด้วย Remove Duplicates  
 
 โปรแกรม Microsoft Excel 2007 ขึ้นไปมีการเพ่ิมความสามารถในการจัดการกับข้อมูลได้หลากหลายขึ้น 
โดยในการจัดการกับข้อมูลที่ซ้ำกันมากๆ สามารถทำได้โดยใช้คำสั่งบนแท็บ Data > Remove Duplicates  
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Workshop :  การประยุกต์ใช้ระบบฐานข้อมูล  (Database )  
 

atabase หรือ ฐานข้อมูล คือ กลุ่มของข้อมูลที่มีความสัมพันธ์ซึ่งกันและกัน โดย
ไม่ได้บังคับว่าข้อมูลทั้งหมดนี้จะต้องเก็บไว้ในแฟ้มข้อมูลเดียวกันหรือแยกเก็บ
หลาย ๆ แฟ้มข้อมูล ประโยชน์ของฐานข้อมูล 

• ลดการเก็บข้อมูลที่ซ้ำซ้อน  

• ร ักษาความถูกต ้องของ
ข้อมูล  

• การป ้องก ันและร ักษา
ความปลอดภัยให้กับข้อมูลทำได้อย่าง
สะดวก การป้องกันและรักษาความ
ปลอดภัยกับข้อมูลระบบฐานข้อมูลจะ
ให้เฉพาะผู ้ท ี ่ เก ี ่ยวข ้องเท่าน ั ้น ซึ่ง

ก่อให้เกิดความปลอดภัย(security) ของข้อมูลด้วย 

 

 

 

 

 

 

 

D 
DATABASE 

ฐานข้อมูลสัญชาติ 

DATABASE 

ฐานข้อมูลประเภทกิจการ 
เมียนม่า ลาว กัมพูชา 
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Workshop :  การรวมข้อมูลด้วยคำสั่ ง  Consolidate  (Excel 2013 )   
 

ata Consolidation allows you to gather together your data from separate worksheets 
into a master worksheet.  In other words, the Data Consolidation function takes data 
from a series of worksheets or workbooks and summaries it into a single worksheet that 
you can update easily. ฟังก์ชั่นของ Microsoft Excel ในการหาข้อมูล SUM , 

หาค่าเฉลี่ย หรืออื่นๆของยอดขายในแต่ละเดือน เราสามารถใช้ฟังก์ชั่นของ Excel 2013 เป็น
ต้นไป ในการทำสูตรเหล่านี้ เพ่ือสรุปเป็นค่าเลขที่เราต้องการ 

 

 

 

 

D 
 

รวมอยู่ใน Worksheet เดียว 
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การจัดการเซลและข้อมูล  
 

ในการจัดการข้อมูลที่กรอกลงในเซลสามารถทำได้หลายวิธี เช่น การแก้ไข การทำซ้ำหรือการคัดลอก
ข้อมูล การย้ายตำแหน่ง เป็นต้น โดยการจัดการกับเซลส่วนใหญ่จะต้องเลือกตำแหน่งเซลก่อน แล้วจึงเลือกคำสั่งที่
ที่ต้องการจัดการกับเซล ดังนี้ (คำสั่งสำคัญต่างๆ จะสามารถเรียกใช้ได้จากการคลิกขวา) 

การคัดลอกเซล (Copy) การย้ายเซล (Cut) 

การวางเซลแบบพิเศษ (Paste Special) 
     การวางแบบพิเศษต่างจากการวางแบบทั่วไปคือ 
การวางทั่วไปจะเป็นการคัดลอกรูปแบบจากต้นฉบับ
ทั้งหมดตั้งแต่ รูปแบบ ลักษณะ สี หรือสูตร แต่การ
วางแบบพิเศษนี้สามารถเลือกได้ว่าต้องการผลลัพธ์ใน
รูปแบบใด มาวางยังตำแหน่งที่ต้องการ มีคำสั่งดังนี้ 
▪ All : คัดลอกคุณสมบัติจากต้นฉบับมาทั้งหมด 
▪ Formulas : คัดลอกเฉพาะสูตร 
▪ Values : คัดลอกเฉพาะค่าของข้อมูลโดยไม่

คัดลอกสูตร 
▪ Format : คัดลอกเฉพาะรูปแบบเซล 
▪ Comments : คัดลอกเฉพาะ Comment 
▪ All using Source theme : คัดลอกเฉพาะธีม 
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การวางเซลแบบพิเศษ (Paste Special ต่อ) 
▪ All except boeders :  คัดลอกทั ้งหมด

ยกเว้นเส้นกรอบ 
▪ Column widths : คัดลอกเฉพาะความ

กว้างคอลัมน์ 
▪ Formulas and number formats : 

คัดลอกเฉพาะสูตร และรูปแบบตัวเลข 
▪ Values and number formats : คัดลอก

เฉพาะค่าของข้อมูล และรูปแบบตัวเลข 
 
     หากเซลที่ต้องการคัดลอก และเซลที่ต้องการวาง
มีค่าเป็นตัวเลข เราสามารถกำหนดให้ทั้ง 2 เซลมีการ
คำนวณก่อนที่จะวางได้ดังนี้ (กลุ่มคำสั่ง Operation) 

▪ None : ไม่มีการคำนวณใดๆ 
▪ Add :  นำเซลท ี ่ค ัดลอกมาบวกก ับเซล

ปลายทางก่อนที่จะวาง 
▪ Subtract : นำเซลที่คัดลอกมาลบกับเซล

ปลายทางก่อนที่จะวาง 
▪ Multiply : นำเซลที่คัดลอกมาคูณกับเซล

ปลายทางก่อนที่จะวาง 
▪ Divide  : นำเซลที ่คัดลอกมาหารกับเซล

ปลายทางก่อนที่จะวาง 
กลุ่มคำสั่งใน Excel 2019 

▪ Skip blanks : ถ้าเซลต้นฉบับเป็นเซลว่าง 
และเซลปลายทางมีข้อมูล เซลปลายทางจะ
ถูกแทนที่ด้วยเซลต้นฉบับที่เป็นเซลว่าง 

▪ Transpose : การวางข้อมูลกลับจากเซล
ต้นฉบับ เช่น จากแนวตั้งเป็นแนวนอน 

 

 
 

ตัวอย่าง 
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การลบเซล (Delete) 
▪ Shift cells left : ลบเซลเดิม และเลื่อนเซลที่อยู่

ด้านขวามาแทนที ่
▪ Shift cells up : ลบเซลเดิม และเลื่อนเซลที่อยู่

ด้านล่างมาแทนที ่
▪ Entire row : ลบทั ้งแถว และเลื่อนเซลที ่อยู่

ด้านล่างมาแทนที ่
▪ Entire column : ลบทั้งคอลัมน์ และเลื่อนเซล

ที่อยู่ด้านขวามาแทนที่ 

 

 
การล้างข้อมูลในเซล (Clear) 

▪ Clear All : ล้างข้อมูลทุกประเภท 
▪ Clear Formats : ล้างเฉพาะรูปแบบ 
▪ Clear Contents : ล้างเฉพาะข้อมูล 
▪ Clear Comments :  ล ้ า ง เ ฉ พ า ะ 

Comment 

 

 

การแทรกเซล / แถว /คอลัมน์ 
1. Insert Cells : การแทรก Cells 
2. Insert Sheet Rows : การเพ่ิมแถว 
3. Insert Sheet Columns : การเพ่ิมคอลัมน์ 
4. Insert Sheet : การเพ่ิม Sheet 

 
การลบเซล /แถว/คอลัมน์ การซ่อน/ยกเลิกการซ่อน 

 

เ ห ม ื อ น
การแทรก
เ ซ ล 
ด้านบน 
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การจัดการกับแถว/คอลัมน์/Worksheet การเรียกใช้ฟังกช์ันการคำนวณยกเลิกการซ่อน 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.uwec.edu/help/Excel07/ws-fills.htm 

การจัดเรียงข้อมูล (Sort) การกรองข้อมูล (Filter) 

 

 

    การเร ียงลำด ับข ้อมูล
ตามเงื ่อนไขที ่กำหนด โดย
ให้คลิก ณ ตำแหน่งภายใน 
Column ที่ต้องการจัดเรียง 
หรือเล ือกพื ้นที ่ท ั ้งหมดที่
ต้องการจัดเรียง และเลือก
คำสั่ง Sort ที่แท็บ Home 

>> กลุ ่มคำส ั ่ง Editing >> Sort & Fillter หร ือที่
แท็บ Data >> กลุ่มคำสั่ง Sort & Fillte  

 

    การกรองข ้อม ูลตาม
เง ื ่ อนไขท ี ่ กำหนด  เ พ่ือ
ต ร ว จ ส อบ ข ้ อ ม ู ล ต า ม
เงื่อนไขที่กำหนด 
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Workshop :  การจัดเรียงข้อมูล (Sort )  

 

 

 

 

 

1 
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Workshop :  การกรองข้อมูล  (Filter ) และการกรองข้อมูลด้วย สี 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 

1 

4.5 

4.3 

4.2 

4.4 

3.1 

3.2 
4.1 
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การกรองข้อมูลโดยใช้เงื่อนไขขั้นสูง  (Advance Filter ) 
 
 หากต้องการกำหนดเงื่อนไขในการกรองข้อมูลโปรแกรม Excel 2019 และ Excel 2007 สามารถที่จะ
กำหนดเงื่อนไขในการกรองข้อมูลที่มีเงื่อนไขได้ 

When you use the Advanced Filter, you need to enter the criteria on the worksheet. Create 
a Criteria range (blue border below for illustration only) above your data set. Use the same column 
headers. Be sure there's at least one blank row between your Criteria range and data set.  

 
  

  

3 

1. กำหนดเงื่อนไข 

2. Filter 

3. Advanced 

4 



 

 64 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิ ศ
ท.

 ก
ลุ่ม

พัฒ
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อร
์แล

ะเค
รือ

ข่า
ย 

| [
M

icr
os

of
 O

ffi
ce

 E
xc

e 
Ad

va
nc

ed
 l 

20
19

]  
- ว

รา
ภร

ณ
์ ไต

รศ
ักด

ิศ์ร
ี 

Workshop :  การค้นหาข้อมูลและแทนที่  (Find & Select ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

2 

1 

3 

การแทนที่ (Replace) 
▪ Find What : ใส่ข้อความที่ต้องการค้นหา

ในช่อง 
▪ Replace With :  ใส่ข้อความที่ต้องการ

ให้แทนที่ในช่อง  
 

กำหนดทางเลือก (Option)  
▪ Search by : ค้นหาตามแนวนอน(Row) 

แนวตั้ง (Column)  
▪ Look in :  ค ้ นห าข ้ อ ค ว า ม ใน  ส ู ต ร

(Formula) ค่าข้อมูล (Value) คำอธิบาย
(Notes)  

▪ Match Case : การค้นหาคำนึงถึงตัวพิมพ์
เล็กพิมพ์ใหญ่  

▪ Find Entire Cells Only : ค้นหาคำโดด ๆ 
เป็นส่วนประกอบของคำอ่ืน  

 



 

 

 

65 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิศ
ทก

. ก
ลุ่ม

พฒั
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อ์แ
ละ

เค
รือ

ข่า
ย 

[M
icr

os
of

 O
ffi

ce
 E

xc
e 

Ad
va

nc
ed

 l 
20

19
] –

 ว
รา

ภร
ณ

 ์ไต
รศ

ักด
ิ์ศร

ี  

การฟังก์ชัน Transpose  ในการปรับเปลี่ยนรูปแบบข้อมูล  
 

 ฟังก์ชัน Transpose เป็นฟังก์ชันที่ใช้ในการสลับตำแหน่งข้อมูลจากแถวเป็นคอลัมน์ หรือคอลัมน์เป็นแถว 
โดยช่วงข้อมูลที่ใช้ฟังก์ชัน Transpose สามารถเปลี่ยนแปลงแบบเชื่อมโยงโดยอัตโนมัติ  
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การตั้ งชื่อเซลล์  (Name box )  
 
 ปกติการเขียนสูตรคำนวณที่มีการอ้างอิงไปยังเซลล์อื่นหรือชีทงานอื่น ค่อนข้างยุ่งยากในการทำความเข้าใจ
ที่มาที่ไปของสูตร โดยเฉพาะกรณีที่เราไม่ได้สร้างสูตรนั้นเอง ดังนั้นวิธีแก้ปัญหาคือตั้งชื่อเซลล์ ซึ่งจะทำให้สูตรที่เขียน 
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การแก้ไขการตั้ งชื่อเซลล์  (Name box ) ด้วย Name Manager  

 
 สำหรับตัวช่วยในการจัดการ แก้ไขการตั้งชื่อเซลล์ คือ Name Manager โดยสามารถเรียกใช้ได้จากแท็บ 
Formulas > Name Manager 
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Workshop :  การแก้ไขการตั้ งชื่อเซลล์  (Name box) เพื่อทำ Spark Line 
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การแสดงสูตร  

 
 โดยปกติทั่วไปเราสามารถแสดงสูตรที่สร้างขึ้นโดยคลิกที่เซลล์นั้นๆ หรือกด F2 หรือดูบนแท็บ Formulas 
หรือเรียกใช้จากแท็บ Formulas > Show Formulas (MS Offce 2013) หรือปุ่ม Formulas Auditing (MS Offce 
2007-2010) 

 
การป้องกันไม่ เห็นสูตร/ไม่ให้แก้ไขสูตร  

 
คำส ั ่ งนี้ จะ ใช ้ควบคู่ ก ับก ับการเล ื อก 

Protect Sheet ที่อยู่บนแท็บ Review 
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การวิ เคราะห์ข้อมูลด้วย  Microsoft Excel  
 
 หากต้องการใช้ความสามารถของโปรแกรม Microsoft Excel สามารถทำได้ตามรายละเอียดดังนี้ 
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 การคำนวณและฟังก์ชัน  

 

 Microsoft Excel 2019 มีความสามารถอย่างมากในการคำนวณด้านต่างๆ เช่น ด้านการเงิน ตรรกะ วันที่ 
เวลา คณิตศาสตร์ หรือด้านสถิติ เป็นต้น รวมทั้งยังมีฟังก์ชั่นมาตรฐานสำหรับการใช้งานทั่วไป และฟังก์ชั่นการ
คำนวณที่ซับซ้อนหลากหลายที่รองรับการใช้งาน โดยผู้ใช้สามารถเรียกใช้ผ่านการพิมพ์คำสั่งบน Formulas Bar 
โดยตรง หรือเรียกใช้คำใช้คำสั่งได้จากแท็บ Formulas ดังภาพ 

 
 

การคำนวณด้วยสูตร การคำนวณด้วยฟังก์ชั่นสำเร็จรูป 
 

 

 

 
 

การคำนวณด้วยสูตร  
 
 ในการคำนวณข้อมูลในโปรแกรม Microsoft Excel จะต้องพิมพ์เครื่องหมายเท่ากับ (=) ลงในเซลที่ต้องการ
คำนวณ และตามด้วยสูตรที่ต้องการคำนวณซึ่งจะประกอบด้วยค่าที่ต้องการดำเนินการ และตัวดำเนินการ (Operator)  
 
 
 
 
 
 
 
 

การอ้างอิงตำแหน่งเซล  
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การอ้างอิงตำแหน่งเซล คำอธิบาย 

Relative Reference เป็นการอ้างอิงตำแหน่งเซลแบบสัมพัทธ์ คือ เซลที่ถูกคัดลอกหรือย้ายตำแหน่งจะถูก
เปลี่ยนตำแหน่งโดยอัตโนมัติเมื่อวางที่เซลปลายทาง 

Absolute Reference เป็นการอ้างอิงเซลแบบสัมบรูณ์ คือ เซลที่ถูกคัดลอกหรือย้ายตำแหน่งจะคงตำแหน่ง
เดิมเมื่อวางที่เซลปลายทาง โดยสามารถกำหนดให้แถวหรือคอลัมน์คงตำแหน่งเดิมได้
โดยใส่เครื่องหมาย $ ไว้หน้าแถวหรือหน้าคอลัมน์ 

Mixed Reference เป็นการอ้างอิงเซลแบบผสมทั้ง Relative Reference และ Absolute Reference 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

การแสดงข้อความผิดพลาดใน  Excel 
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 ในบางครั้งที่เราใช้สูตรในการคำนวณอาจเกิดข้อผิดพลาดที่โปรแกรม Microsoft Excel ได้แสดงข้อความ
ผิดพลาดให้ผู้ใช้ทราบได้ดังนี้ 
 

ข้อความแสดงความผิดพลาด สาเหตุ 

##### ข้อมูลในเซลมีความยาวเกินกว่าที่แสดงผลได้ 

#VALUE! ใช้ตัวดำเนินการ (Operand) หรืออาร์กิวเมนต์ผิดประเภท 

#NULL! เซลที่อ้างอิงผิด ทำให้ไม่สามารถกำหนดเซลที่ต้องการได้ 

#DIV/0! ตัวหารเป็นศูนย์ 

#NAME! พิมพ์ชื่อของฟังก์ชันท่ใช้ในสูตรโดยสะกดไม่ถูกต้อง  หรือไม่มีชื ่อเซลที่อ้างอิง 
หรือไม่มีชื่อฟังก์ชั่น ใส่ Argument ผิด ใช้ข้อความตัวอักษรโดยไม่ใส่เครื่องหมาย 
“” 

#N/A การใส่ Argument ให้ฟังก์ชันไม่ครบ หรือใช้ค่า Argument ที่ไม่ถูกกับฟังก์ชัน  

#REF! เซลที่อ้างอิงถูกลบ หรือถูกข้อมูลจากเซลล์อ่ืนย้ายมาทับแทนที่ 

#NUM! ใช้ Argument ที่ไม่ใช่ตัวเลขกับสูตรที่ต้องใช้ตัวเลข 

 
การใส่ข้อมูลแบบอัตโนมัติ  (Auto Fi ll ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto Fill 
 
     เ ป ็ น ก า รป ้ อนข ้ อมู ล
ตามลำดับจากข้อมูลเริ ่มต้น
ในนอนหรือแนวตั้ง มีวิธีการ
ดังนี้ 
1. พิมพ์ข้อมูลเริ่มต้น 
2. Highlight Cell 
3. นำ Mouse วางลงบน

ด้านล่างขวาของเซล 
4. ล า ก  Mouse ไ ป

ตำแหน่งที่ต้องการ 
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การคำนวณด้วยฟังก์ชั่นสำเร็จรูป  (Function ) 
 

คือสูตรการคำนวณที ่โปรแกรม Microsoft Excel 
สร้างไว้ให้เพื ่อสนับสนุนการทำงานประเภทต่างๆ 
โดยแต่ละฟังก์ชั่นมีรูปแบบมาตรฐานการใช้งาน ดังนี้ 

 
 

Function name (Argument 1 , Argument 2 , Argument 3 , … ,Argument n ) 

 
 

Function name Argument 

คือชื่อที่เรียกใช้ฟังก์ชั่น โดยปกติชื่อจะแสดงถึงลักษณะ
การทำงานของฟังก์ชั่น เช่น ฟังก์ชั่น SUM เป็นฟังก์ชั่นที่
ใช้ในการคำนวณผลรวมของ Argument ที่กำหนด 

คือค่าที่ฟังก์ชั่นจะนำไปคำนวณ โดย Argument จะอยู่
ภายในวงเล็บและแยกกันด้วยเครื่องหมายคอมม่า (,) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Function 
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การเรียกใช้งานฟังก์ชั่นสำเร็จรูป  
 

▪ พิมพ์ชื่อ Function และ Argument ลงในเซลที่ต้องการโดยตรง : เหมาะกับผู้ใช้ที่รู้ชื่อ Function หรือ 
Agrument (โปรแกรม Microsoft Excel จะแสดงรูปแบบการใส่ Agrument ให้) 

 

▪ เลือก Funtion จากไลบรารี่ : ไลบรารีเป็นแหล่งรวม Function ที่ถูกรวบรวมไว้เป็นกลุ่ม โดยแยกตาม
ประเภทการใช้งาน โดยสามารถเรียกใช้ได้จากแท็บ Formulas 

 

กลุ่มฟังก์ชั่น ความหมาย 

Finalcial  ฟังก์ชันเกี่ยวกับด้านการเงิน เช่น การชำระค่างวด หรืออัตราดอกเบี้ย เป็นต้น 

Logical  ฟังก์ชันเกี่ยวกับการคำนวณแบบมีเงื่อนไขตรรกะทางคณิตศาสตร์ มีผลลัพธ์ที่เป็นจริง 
หรือเป็นเท็จ 

Text ฟังก์ชันเกี่ยวกับข้อมูลประเภทตัวอักษร เช่น การแปลงตัวอักษร การตัดคำ การต่อคำ เป็นต้น 

Date & Time  ฟังก์ชันเกี่ยวกับวันและเวลา เช่นการแปลงค่าวัน เวลา หรือการเพิ่ม-ลด วันเวลาเป็นต้น 

Lookup & Reference ฟังก์ชันเกี่ยวกับการค้นหา และการอ้างอิงข้อมูลภายในตารางตามเงื่อนไขที่กำหนด 

Math & Trig ฟังก์ชันเกี่ยวกับการคำนวณทางคณิตศาสตร์ เช่น ผลรวม หรือหารากที่สอง เป็นต้น 

More Function ฟังก์ชันเกี่ยวกับสูตรในด้านอ่ืนๆ เช่น ทางด้านสถิติ วิศวกรรมศาสตร์ เป็นต้น 

   
 
 
 
 
 
 
 

ฟังก์ชั่นสำเร็จรูปที่ เ รียกใช้งานประจำ  
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ชื่อฟังก์ชัน รูปแบบของฟังก์ชัน การนำไปใช้ 

SUM SUM(จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ในการหาผลรวมของข้อมูล 
AVERAGE AVERAGE(จำนวนที่1 , จำนวนที่ 2 , n) ใช้หาค่าเฉลี่ย 
COUNT COUNT(จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้นับจำนวนข้อมูล 
DATE DATE(จำนวนที่ 1 , จำนวนที่ 2 , n) แปลงค่า ปี, เดือน, วัน ให้กลายเป็นตัวเลขที่  Excel 

สามารถนำไปคำนวณได้ 
IF IF (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ตรวจสอบเงื่อนไขที่กำหนด 
MAX MAX (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ค้นหาข้อมูลที่มีค่ามากที่สุด 
MIN MIN (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ค้นหาข้อมูลที่มีค่าน้อยที่สุด 
ABS ABS (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ในการหาค่าสัมบูรณ์ (เลขที่ไม่มีเครื่องหมายลบ) ของ

ตัวเลข เช่น ABS (-1) เท่ากับ 1 และ ABS (1) เท่ากับ 1 
ROUND ROUND (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ปัดเศษเลขทศนิยมโดยวิธีที่นิยมกันคือ ถ้าน้อยกว่า .5 

ให้ปัดลงนอกนั้นให้ปัดขึ้น ดังนั้น 5.5 ก็จะถูกปัดเป็น 6 
FLOOR FLOOR (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ปัดเศษเลขทศนิยมทิ้ง 
RANK RANK (จำนวนที่ 1 , จำนวนที่ 2 , n) ใช้ในการหาลำดับข้อมูลว่าข้อมูลที่เรามีอยู่ในลำดับที่

เท่าใด 
HYPERLINK HYPERLINK (จำนวนที่1 , จำนวนที่ 2 , n)  ใช้ในการสร้างการเชื่อมโยงไปยังเอกสารอ่ืน 

Refference : http://office.microsoft.com/th-th/excel-help/HP005204211.aspx 

 
การอ้างอิงตำแหน่งเซล คำอธิบาย 

การอ้างอิงเซลที่อยู่ในเวิร์คชีตเดียวกัน เป็นการใช้ข้อมูลของเซลที่อยู่ในเวิร์คชีตเดียวกันในการคำนวณ โดยสูตรที่
สร้างขึ้นจะประกอบด้วยตำแหน่งอ้างอิงเซล เช่น =SUM(B1:B3) 

การอ้างอิงเซลที่อยู่ต่างเวิร์คชีต เป็นการใช้ข้อมูลของเซลที่อยู่ต่างเวิร์คชีตในการคำนวณ โดยสูตรที่สร้างขึ้นจะ
ประกอบด้วยตำแหน่งอ้างอิงเซล เช่น =SUM(ชื่อเวิร์คชีต!B1:B3) 

การอ้างอิงเซลที่อยู่ต่างไฟล์ เป็นการใช้ข้อมูลของเซลที่อยู่ต่างเวิร์คชีตในการคำนวณ โดยสูตรที่สร้างขึ้นจะ
ประกอบด้วยตำแหน่งอ้างอิงเซล เช่น =SUM([ชื่อไฟล์]ชื่อเวิร์คชีต!B1:B3) 

การอ้างอิงโดยใช้กลุ ่มเซล (Ranges 
Name) 

เป็นการตั้งชื่อกลุ่มของเซล เพื่อนำไปใช้อ้างอิงในสูตร  
- แท็บ Formulas > Define Name 
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Workshop  : SUM – AVERAGE – MAX - MIN 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 

1.2 

4.1 
3.1 

1.3 

2.1 

2.2 

2.3 

5 
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ฟังก์ชันเกี่ยวกับข้อความ  
 
 โปรแกรม Microsoft Excel มีฟังก์ชันหลากหลายในการใช้งานเกี่ยวกับข้อความ เพ่ือตอบสนองความ
ต้องการของผู้ใช้งานที่หลากหลาย เช่น ต้องการแยกข้อความออกเป็นอีกคอลัมน์ การหาความยาวของข้อความ 
เป็นต้น โดยผู้ใช้งานสามารถปรับประยุกต์ได้ตามต้องการ 

ชื่อฟังก์ชันเกี่ยวกับข้อความ ชื่อฟังก์ชันเกี่ยวกับข้อความ 
LEN  
นับจำนวนตัวอักษร (นับทั้งอักษร ช่องว่าง สระ และ
วรรณยุกต์ด้วย) 

 
=LEN(text) 
=LEN(ข้อความที่จะนับอักษร) 
ผลลัพธ์ : เป็น Number 
ตัวอย่าง : =LEN(“มดแดง”) =5 
 

LEFT  
ตัดคำจากทางซ้าย (ระบุได้ว่าตัดกี่ตัวอักษร) 

 
=LEFT(text, [fusion_builder_container 
hundred_percent=”yes” 
overflow=”visible”][fusion_builder_row][fusion
_builder_column type=”1_1″ 
background_position=”left top” 
background_color=”” border_size=”” 
border_color=”” border_style=”solid” 
spacing=”yes” background_image=”” 
background_repeat=”no-repeat” padding=”” 
margin_top=”0px” margin_bottom=”0px” 
class=”” id=”” animation_type=”” 
animation_speed=”0.3″ 
animation_direction=”left” 
hide_on_mobile=”no” center_content=”no” 
min_height=”none”][num_chars]) 
=LEFT(ข้อความต้นฉบับ, [จำนวนอักษรที่จะตัด]) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =LEFT(“มดแดง”,2) =“มด” 
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ชื่อฟังก์ชันเกี่ยวกับข้อความ ชื่อฟังก์ชันเกี่ยวกับข้อความ 
MID  
ตัดคำโดยระบุได้ว่าเริ่มตัดที่ตำแหน่งไหน เป็นจำนวนกี่
ตัวอักษร 

 
=MID(text,start_num,num_chars) 
=MID(ข้อความต้นฉบับ,อักษรที่เริ่มตัด,จำนวนอักษรที่
จะตัด) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =MID(“มดแดง”,3,2) =“แด” 
 

RIGHT  
ตัดคำจากทางขวา (ระบุได้ว่าตัดกี่ตัวอักษร) 

 
=RIGHT(text, [num_chars]) 
=RIGHT(ข้อความต้นฉบับ, [จำนวนอักษรที่จะตัด]) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =RIGHT(“มดแดง”,2) =“ดง” 
 

TRIM  
ตัดช่องว่างส่วนเกินออก (ลบช่องว่างที่อยู่หน้า หลัง 
รวมถึงช่องว่างตรงกลางที่เกิน 1 เคาะ) 

 
=TRIM(text) 
=TRIM(ข้อความที่จะตัด) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =TRIM(”  inw  excel “) =”inw excel” 
(เหลือช่องว่างกลาง 1 space) 
  
 

FIND 
ค้นหาคำท่ีต้องการ ว่าอยู่ตำแหน่งที่เท่าไหร่ของข้อความ
ที่กำหนด (สนใจตัวพิพม์เล็กพิมพ์ใหญ่) ระบุได้ว่าให้เริ่ม
หาตั้งแต่อักษรที่เท่าไหร่ 

 
=FIND(find_text, within_text, [start_num]) 
=FIND(ส่วนของคำที่ต้องการหา, หาในคำไหน, 
[ตำแหน่งที่เริ่มหา]) 
ผลลัพธ์ : เป็น Number 
ตัวอย่าง : =FIND(“Excel”,”inwexcel is 
Excellent”) =13 
 
 
 

http://www.inwexcel.com/wp-content/uploads/2015/04/mid-fix.png
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ชื่อฟังก์ชันเกี่ยวกับข้อความ ชื่อฟังก์ชันเกี่ยวกับข้อความ 
SEARCH  
ค้นหาคำท่ีต้องการ ว่าอยู่ตำแหน่งที่เท่าไหร่ของข้อความที่
กำหนด โดยใช้การหาแบบ Wildcard (ไม่สนใจตัวพิพม์
เล็กพิมพ์ใหญ่) ระบุได้ว่าให้เริ่มหาตั้งแต่อักษรที่เท่าไหร่ 

 
=SEARCH(find_text,within_text,[start_num]) 
=SEARCH(ส่วนของคำที่ต้องการหา, หาในคำไหน, 
[ตำแหน่งที่เริ่มหา]) 
ผลลัพธ์ : เป็น Number 
ตัวอย่าง : =SEARCH(“Excel”,”inwexcel is 
Excellent”) =4 

SUBSTITUTE  
แทนที่คำที่ต้องการด้วยอีกคำหนึ่ง ใช้เมื่อรู้คำที่จะถูก
แทนที่ 

 
=SUBSTITUTE(text, old_text, new_text, 
[instance_num]) 
=SUBSTITUTE(คำที่ต้องการแทนที่, ส่วนของคำเดิม
ที่จะถูกแทนที่, ส่วนของคำใหม่ที่จะมาแทนที่, 
[เจาะจงอันที่ถูกแทนที่ได้]) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =SUBSTITUTE(“ผม like มาก”,”like”,”
ชอบ”) = “ผม ชอบ มาก” 

REPLACE  
แทนที่ตำแหน่งที่ต้องการด้วยอีกคำหนึ่ง ใช้เมื่อรู้ตำแหน่ง
และจำนวนตัวอักษรที่จะถูกแทนที่ 

TEXT  
เปลี่ยนรูปแบบ Number Format โดยใช้สูตร 

 
=TEXT(value, format_text) 
ในช่อง format_text ให้ใส่รูปแบบคล้ายการทำ 
Custom Format ซึ่งจะอธิบายต่อไปในบทหลัง 
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ชื่อฟังก์ชันเกี่ยวกับข้อความ ชื่อฟังก์ชันเกี่ยวกับข้อความ 

 
=REPLACE(old_text, start_num, num_chars, 
new_text) 
=REPLACE(คำที่ต้องการแทนที่, ตำแหน่งเริ่มทีจ่ะ
แทนที่, จำนวนอักษรที่จะแทนที่, คำใหม่ที่จะมาแทนที่) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =REPLACE(“081-234-5678”,5,3, “ไม่
บอก”) = “081-ไม่บอก-5678” 
 

ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =TEXT(1234.5678,”0.00″)= “1234.57” 
 

UPPER  
แปลงข้อความให้กลายเป็นตัวพิมพ์ใหญ่ทั้งหมด 

 
= UPPER(text) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =UPPER(“mOnKey”)= “MONKEY” 
 

LOWER  
แปลงข้อความให้กลายเป็นตัวพิมพ์เล็กทั้งหมด 

 
= LOWER(text) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =LOWER(“mOnKey”)= “monkey” 
 

PROPER  
แปลงข้อความแต่ละคำให้ขึ้นต้นด้วยตัวพิมพ์ใหญ่ นอกนั้น
ตัวพิมพ์เล็กท้ังหมด 

Bathtext 
แปลงตัวเลขเป็นตัวอักษร 

=BAHTTEXT(Number) 

ตัวอย่าง =BAHTTEXT(99.95) 
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ชื่อฟังก์ชันเกี่ยวกับข้อความ ชื่อฟังก์ชันเกี่ยวกับข้อความ 

 
= PROPER(text) 
ผลลัพธ์ : เป็น Text 
ตัวอย่าง : =PROPER(“mOnKey”)= “Monkey” 
 

ผลลัพธ์ คือ เก้าสิบเก้าบาทเก้าสิบห้าสตางค์ 

 

Ref : http://www.inwexcel.com/text-function/ 

 

 

 

Workshop :  การแยกข้อความเป็นคอลัมน์ด้วยฟังก์ชัน  
 

 

 

http://www.inwexcel.com/text-function/
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Workshop  :  การแยกข้อความเป็นคอลัมน์ด้วยคำสั่ง  Text to Coloum 
 
 หากลักษณะข้อมูลในบางคอลัมน์มีการใช้ช่องว่าง สัญลักษณ์ในการแบ่งข้อความก็สามารถใชคำสั่ง Text 
to Column ในการแยกข้อความเป็นคอลัมน์ใหม่ได้ แต่ผู้ใช้งานควรตรวจสอบและทำความเข้าใจในเรื่องข้อมูล
ภายในคอลัมน์นั้นๆ ให้เข้าใจก่อนเพราะจะมีผลต่อคอลัมน์ที่สร้างขึ้น  

 

 

 

เลือกข้อมูลที่ต้องการแยก
เป็นคอลัมน์ใหม่ 

Delimited กรณีท่ีข้อความ
นั้นมีตัวแบ่งข้อความ 
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ชนิดของ Delimiter  

General  

แยกข้อความเป็นคอลัมน์ใหม่ 
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Workshop  : การใช้ฟังก์ชัน IF 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

7 

5 

4 

3 2 

B และ C  
ทำคล้ายกับ A 

6 
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Workshop : การใช้ฟังก์ชัน IFS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 function checks whether one or more conditions are met, and returns a value 
that corresponds to the first TRUE condition. IFS can take the place of multiple 
nested IF statements, and is much easier to read with multiple conditions. 

 
=IFS([Something is True1, Value if True1,Something is True2,Value 
if True2,Something is True3,Value if True3) 
  

IFS 

Data 

CONDITION 

Data 

“GOOD” 

TRUE FLASE 

CONDITION 
TRUE FLASE 

Data 

Please note that the IFS function 
allows you to test up to 127 different 

conditions. However, we don't 
recommend nesting too many 

conditions with IF or IFS statements. 
This is because multiple conditions 

need to be entered in the correct order, 
and can be very difficult to build, test 

and update. 
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Workshop : การใช้ฟังก์ชัน SWITCH 
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Workshop  : SUMIF  
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Workshop  : SUMIF  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 

3 

4.1 

4.4 

4.2 4.3 

4.4 

1 
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Workshop  :  Pivot Table  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2.1 

3 

4 

5 

2.2 
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Workshop :  Pivot Table  (ต่อ) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 

7.2 
7.3 

7.1 

5 
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Workshop :  ROUND – ROUNDUP -ROUNDDOWN  
 
Excel ROUND function 

ROUND is the major rounding function in Excel that rounds a numeric value to a 
specified number of digits. 
Syntax: ROUND(number, num_digits) 

- Number - any real number you want to 
round. This can be a number, reference 
to a cell containing the number or a 
formula-driven value. 

- Num_digits - the number of digits to 
round the number to. You can supply a 
positive or negative value in this 
argument: 

 

 
 
 
 
 
 
 
 
 
 
 
 

▪ Round : ใช้เลข 5 เป็นเกณฑ์ ในการ
ปัดตัวเลขขึ้นหรือลง 

▪ RoundUp : ปัดตัวเลขขึ้น ให้เหลือ
จำนวนหลักตัวเลขตามต้องการ 

▪ RoundDown :  ปัดต ัวเลขลง ให้
เหลือจำนวนหลักตัวเลขตามต้องการ 

http://www.tpa.or.th/xlsiam/application/rrounding.html#ROUND
http://www.tpa.or.th/xlsiam/application/rrounding.html#ROUNDUP
http://www.tpa.or.th/xlsiam/application/rrounding.html#ROUNDDOWN
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Excel ROUNDUP function 
The ROUNDUP function rounds the number upward (away from 0) to a specified number 

of digits. 
Syntax: ROUNDUP(number, num_digits) 

- Number - the number to be rounded up. 
- Num_digits -  the number of digits you want to round the number to.  You can supply 

both positive and negative numbers in this argument, and it works like num_digits of the 
ROUND function discussed above, except that a number is always rounded upward. 

 

 
 
Excel ROUNDDOWN function 

The ROUNDDOWN function in Excel does the opposite of what ROUNDUP does, i.e. 
rounds a number down, toward zero. 
Syntax: ROUNDDOWN(number, num_digits) 

- Number - the number to be rounded down. 
- Num_digits - the number of digits you want to round the number to. It works like the 

num_digits argument of the ROUND function, except that a number is always rounded 
downward. 
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Workshop :  ทำรายการอัตโนมัติด้วย Data Validation 
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Workshop  :  การใช้ฟังก์ชั่น Match แบบ Extract 
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การค้นหาข้อมูลตามแนวคอลัมน์  (VLOOKUP ) 
 

 สามารถใช้ ค้นหาค่าที ่เราต้องการ ด้วยการกำหนดค่า
อ้างอิง จากคอลัมภ์ (Column) ที่อยู่ซ้ายสุดในตารางข้อมูล 
(Table_array) เพ่ือคืนค่าคำตอบจาก "แถว(Row) เดียวกัน" 

ด้วยคอลัมภ์ (Column) ที่เรากำหนดขึ้น และเงื่อนไขคือ ตารางข้อมูล (Table_array) ที่ใช้ Vlookup ค้นหา ต้อง
เป็นตารางที่มีการ Sort หรือจัดเรียงแล้วและไม่ควรมีข้อมูลซ้ำๆ กันหลายแถว เพราะจะทำให้หาข้อมูลไม่เจอ หรือ 
ให้ผลลัพท์ท่ีผิดพลาดได ้

รูปแบบของฟังก์ชั่น 

=VLOOKUP(lookup_value,table_array,col_index_num,range_lookup) 

▪ Lookup_value คือค่าอ้างอิงซึ่งอาจเป็น ตัวเลข หรือตัวอักษรก็ได้ เพ่ือให้สูตรค้นหาข้อมูล จากตาราง
หลัก  

▪ Table_array ตารางข้อมูลเบื้องต้น ใช้เก็บข้อมูล ตัวอักษร,ตัวเลข  
▪ Col_index_num อันดับของ Column ใน Table_array โดยนับ Coulmn แรกเป็นคอลัมภ์ที่ 1  
▪ Range_lookup เพ่ือให้ฟังก์ชั่นคืนค่าตามเงื่อนไข TRUE (omitted)/ FALSE (exact value) 

 

 

 

 

VLOOKUP 
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Workshop :  การค้นหาข้อมูลตามแนวคอลัมน์  (VLOOKUP ) 
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การค้นหาข้อมูลตามแนวแถว  (HLOOKUP ) 
 

 is an Excel function to lookup and retrieve data from 
a specific row in table. The "H" in HLOOKUP stands for 
"horizontal", where lookup values appear in the first 

row of the table, moving horizontally to the right. HLOOKUP supports approximate and exact 
matching, and wildcards (* ?) for finding partial matches. 

Purpose : Look up a value in a table by matching on the first row 

Return value : The matched value from a table. 

Syntax =HLOOKUP (value, table, row_index, [range_lookup]) 

Arguments  
- value - The value to look up.  
- table - The table from which to retrieve data. 
- row_index - The row number from which to retrieve data. 
- range_lookup - [optional] A boolean to indicate exact match or approximate match. 

Default = TRUE = approximate match. 

 

 

HLOOKUP 
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 คำสั่งบนแท็บ  Insert 

 

 บนโปรแกรม Microsoft Execl 2010 ได้รวบรวมกลุ่มของคำสั่งที่จะใช้ในการแทรกข้อมูลต่างๆ ลงใน 
Worksheet เช่น รูปภาพ รูปทรง กราฟ การใส่ Link กล่องข้อความ เป็นต้น สังเกตว่ากลุ่มคำสั่งส่วนใหญ่จะคล้าย
กับโปรแกรม Microsoft Word 2010 ทำให้ผู้ใช้สามารถใช้งานคำสั่งได้คล้ายกัน โดยสามารถเรียกใช้คำสั่งในการ
แทรกข้อมูลต่างๆ ได้จากแท็บ Insert ดังภาพ 

 

กลุ่มคำสั่ง อธิบาย 
Tables กลุ่มคำสั่งที่ใช้ในการสร้างรายงานแบบสรุป (Pivot Table)  การสร้างตาราง (Table) 
Illustations กลุ่มคำสั่งที่ใช้ในการแทรกรูป รูปภาพสำเร็จรูปจากโปรแกรม (Clip Art) รูปทรง หรือ

รูปทรางกราฟฟิก โดยการใช้งานคำสั่งจะเหมือนกับโปรแกรม MS Word 2010 
Charts กลุ่มคำสั่งที่ใช้ในการสร้างกราฟแบบต่างๆ เช่น กราฟแท่ง กราฟวงกลม เป็นต้น 
Links กลุ่มคำสั่งที่ใช้ในการสร้างลิงค์สำหรับเชื่อมโยงระหว่าง Worksheet ไฟล์ หรือเว็บ เป็น

ต้น 
Text กลุ่มคำสั่งที ่ใช้ในการแทรกกล่องข้อความ ข้อความหัวตาราง (Header & Footer) 

สัญลักษณ์พิเศษ เป็นต้น 
 
 
 
 
 
 
 
 

Workshop :  การสร้าง Hyperlink   
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1.1 

1.3 

2.3 

2.1 

3.1 

2.2 

3.2 

3.3 



 

 102 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิ ศ
ท.

 ก
ลุ่ม

พัฒ
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อร
์แล

ะเค
รือ

ข่า
ย 

| [
M

icr
os

of
 O

ffi
ce

 E
xc

e 
Ad

va
nc

ed
 l 

20
19

]  
- ว

รา
ภร

ณ
์ ไต

รศ
ักด

ิศ์ร
ี 

 
การสร้างกราฟ  

 
ความสามารถในการตกแต่งตารางข้อมูล โปรแกรม Microsoft Excel สามารถตกแต่งตารางข้อมูลหรือกราฟ 

ข้อมูลด้วยภาพ สี และรูปแบบตัวอักษรต่าง ๆ เพื่อให้เกิดความสวยงามและทำให้แยกแยะข้อมูลได้ง่ายขึ้น โดยเรียกใช้
คำสั่งในการสร้างกราฟได้จากแท็บ Insert >> กลุ่มคำสั่ง Charts 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

2 

      ในการแก ้ ไขตบแต ่งกราฟ
สามารถเรียกใช้คำสั่งในการปรับ
รูปแบบกราฟได้จากแท็บ Design 

1 

3.4 
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การสร้างเส้นแนวโน้ม  (Trendline ) 

 
 เส้นแนวโน้ม (Trendline) ในแผนภูมิ เป็นเส้นที่แสดงทิศทางของข้อมูลที่มีการเคลื่อนที่ไปในแนวทางใด
ทางหนึ่ง ตามแนวโน้มนั้นๆ จึงทำให้ทราบถึงแนวโน้มของข้อมูลในอนาคต โดยสามารถนำเส้นแนวโน้มไปใช้ร่วมกับ 
เครื่องมือวิเคราะห์ทางเทคนิคตัวอื่นๆ ได ้มีรายละเอียดการใช้งานดังนี้ 

 

Trendline in Excel 

A trendline, also referred to as a line of best fit, is a straight or curved line in a chart that 
shows the general pattern or overall direction of the data. 

This analytical tool is most often used to show data movements over a period of time or 
correlation between two variables. 
Ref : https://www.ablebits.com/office-addins-blog/2019/01/09/add-trendline-excel/ 
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Workshop  :  การทำ Pivot Table & Slicer  
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Workshop :  การทำ Gantt Chart 
 
 

 

 

 

ขึ้นสามารถอธิบายโดยตัวตนของสูตรนั้นๆ ให้กับผู้ใช้งานได้เข้าใจสูตรที่ใช้งานมากยิ่งขึ้น 
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การใส่ข้อความหัวกระดาษท้ายกระดาษ  (Header & Footer ) 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     การใส่ข้อความหัวกระดาษ-
ท้ายกระดาษสามารถใสข้อความได้
หลายรูปแบบ เช่น ชื่อ Worksheet 
ชื ่อไฟล์ ว ันที ่  เวลา เลขที ่หน้า 
จำนวนหน้า รูปภาพ เป็นต้น โดย
เรียกใช้คำสั ่งได้จากแท็บ Insert 
>> Header & Footer 
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 คำสั่งบนแท็บ  Page Layout 
 

age Layout (เค้าโครงหน้ากระดาษ) เป็นแท็บที่รวบรวมคำสั่งเกี่ยวกับการจัดหน้าเอกสารของ Worksheet 
เช่น การกำหนดเอกสารสำเร็จรูป สีของหน้าเอกสาร การจัดหน้าเอกสาร ระยะขอบเอกสาร การเลือกขนาด
กระดาษให้เหมาะสมกับงาน การกำหนดพื้นที่ในการพิมพ์ การพิมพ์ Header ซ้ำทุกหน้า การจัดวางตำแหน่ง

ข้อความและรูปภาพ (Arrage) เป็นต้น โดยการกำหนดค่าบนแท็บ Page Layout จะมสี่วนจะเกี่ยวข้องกับแท็บ Design 

 

 

กลุ่มคำสั่ง อธิบาย 
Themes กลุ่มคำสั่งที่ใช้ในการกำหนดชุดสีในการตบแต่งตัวอักษร การกำหนดรูปแบบตัวอักษร เป็นต้น 
Page Setup กลุ่มคำสั่งที่ใช้ในการตั้งขอบกระดาษ แนววางกระดาษ พื้นที่พิมพ์ซ้ำ ใส่รูป Background เป็นต้น 
Scale Fit กลุ่มคำสั่งที่ใช้แสดงผลข้อมูลเวลาพิมพ์ให้พอดีกับ Width/Hieght ที่กำหนด ปรับขนาดข้อมูล 
Sheet Option กลุ่มคำสั่งที่ใช้ในการแสดงเส้นตารางสมมุติ (Gridlines) การแสดงพื้นที่พิมพ์ การแสดง Row เป็นต้น 

Arrange กลุ่มคำสั่งที่ใช้ในการจัดตำแหน่งของรูปทรง รูปภาพ การรวม Object เป็นชิ้นเดียวกัน การหมุน  
 

  

    

 

    

 

• Themes : กำหนดชุดสีในการตบแต่งตัวอักษร 

• Color : เหมือน Themes สามารถกำหนดชุดสี
ได้ 

• Fonts : กำหนดรูปแบบตัวอักษรให้กับ 
Themes 

• Effects : กำหนด Effect ให้กับ Themes 

หมายเหตุ : การกำหนด Themes จะมีผลกับกลุม่คำสั่ง 
Styles บนแท็บ Home 

 

 

P 
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ตั้งขอบกระดาษ  (Margin )  

 

เอกสารที่สร้างขึ้นมาใหม่นั้น Microsoft Excel จะตั้งค่าขอบกระดาษ (Margins) หรือระยะห่างระหว่าง 
ข้อความกับริมขอบหน้ากระดาษทั้ง 4 ด้าน เอาไว้ให้แล้วเป็นค่าพื้นฐาน  (Default) ปกติจะใช้ค่าเป็น Normal แต่เรา
สามารถเปลี่ยนแปลงค่าขอบกระดาษได้ เพื่อเว้นพื้นที่ส่วนขอบเตรียมไว้สำหรับการใส่เลขหน้า วันที่ หรือโลโก้ลงไป
ในส่วนที่เรียกว่า Header/Footer โดยคำสั่งนี้จะอยู่ที่แท็บ Page Layout >> Page Setup 

 
ขั้นตอนการตั้งค่าขอบกระดาษ  

1. คลิกแท็บ Page Layout >> กลุ่มคำสั่ง Page Setup >> Margins  
2. คลิกปุม่ Custom Margins เพ่ือกำหนดการตั้งค่า 

 

   
 

1 

2 แนวการวางกระดาษ 

3 

ตั้งขอบทั้ง 4 ด้าน 
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การพิมพ์แถวหรือคอลัมน์ซ้ำทุกหน้า  (Print Title ) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

3 

4 

5 

2 
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การสร้างกราฟแบบ  Sparklines 
 

New in Microsoft Excel 2019, a sparkline is a tiny chart in a worksheet cell that provides a 
visual representation of data. Use sparklines to show trends in a series of values, such as seasonal 
increases or decreases, economic cycles, or to highlight maximum and minimum values. Position 
a sparkline near its data for greatest impact. 

"Sparklines enable us to create visual representations of data with one click. It makes it 
easier to grasp data, and it’s helping our CFO analyze trends on the spot." 

Matt Stuckey, IT Director of Levick Strategic Communications 

What are sparklines? 

Unlike charts on an Excel worksheet, sparklines are not objects — a sparkline is actually 
a tiny chart in the background of a cell.  The following picture shows a column sparkline in cell 
F2 and a line sparkline in F3. Both of these sparklines get their data from cells A2 through E2 and 
display a chart inside a cell that shows the performance of a stock.  The charts show the values 
by quarter, highlight the high value (3/31/08) and the low value (12/31/08) , show all the data 
points, and show the downward trend for the year. 

You can quickly see the relationship between a sparkline and its underlying data, and 
when your data changes you can see the change in the sparkline immediately. In addition to 
creating a single sparkline for a row or column of data, you can create several sparklines at the 
same time by selecting multiple cells that correspond to underlying data, as shown in the 
following picture. 

You can also create sparklines for rows of data that you add later by using the fill 
handle on an adjacent cell that contains a sparkline.                                                                                                                                         
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Dashboard 
 
Business Intelligence is a hot commodity in today’s world and dashboards are the most frequently 

used method of 
providing that 
information.  
So what exactly is a 
dashboard? My 
favorite definition 
comes from Stephen 
Few, “A dashboard is 
a visual display of 
the most important 
information needed 
to achieve one or 
more objectives 
which fits entirely on 
a single computer 
screen so it can be 
monitored at a 
glance.” This echoes 
a theme that I once 
heard in a session 

lead by David Paradi at the PowerPoint Live Conference (now The Presentation Summit)  about 
using the GAR (Glance, Absorb, and Return.) principle. Rick Altman, the host of The Presentation 
Summit has graciously agreed to let me use data from his conference to create the example 
dashboard used for this article.  Note that I’ ve used aliases for topics and presenters to protect 
sensitive business information and speaker’s privacy. 
SharePoint and Excel are the most frequently used Microsoft mediums for creating dashboards 
(see the Microsoft Help Article: Introduction to Business Intelligence Features). Though frequently 
overlooked, PowerPoint combined with Excel offers an easy solution for creating elegant and 

http://office.microsoft.com/en-us/excel-help/redir/HA010087218.aspx?CTT=5&origin=HA102298884
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functional dashboards.  Additionally, PowerPoint offers an interactivity feature not available in 
other applications. 
When creating any dashboard, the first rule of thumb should be that the data is the star. Cluttering 
the screen with unnecessary components will distract from the information displayed, so a KISS 
(Keep It Simple Stupid)  approach is best.  You’ ll want to strike a balance between making your 
dashboard attractive enough to hold your audience’s interest, but not so stylized that it obscures 
the information displayed. A best practice is to avoid 3D charts and if information can be displayed 
more clearly in a table than a chart it should be in a table.  Excel has a wonderful conditional 
formatting feature that allows you to have both: a graphical display within a table. 
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กำหนดการแสดงผลของ  Worksheet  (Sheet Option ) 
 
 ในการกำหนดการแสดงผลข้อมูลบน Worksheet สามารถ
เรียกใช้คำสั่งได้จากแท็บ Page Layout >> Sheet Options หรือ
แท็บ View >> Show/Hide 

▪ Gridlines : การแสดงผลเส้นตารางสมมุติ (Grid) 
o View : การแสดงเส้นตารางสมมุติ (Grid) 
o Print : การแสดงเส้นตารางสมมุติ (Grid) เมื่อพิมพ์ข้อมูล 

▪ Headings : การแสดงผลเส้นตารางสมมุติ 
o View : การแสดงชื่อคอลัมน์และแถว 
o Print : การแสดงชื่อคอลัมน์และแถวเมื่อพิมพ์ข้อมูล 
 
 
 
 

การพิมพ์แถวหรือคอลัมน์ซ้ำทุกหน้า  (Print Title ) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

4 



 

 116 

สำ
นัก

งา
นส

ถิต
ิแห

่งช
าต

 ิ ศ
ท.

 ก
ลุ่ม

พัฒ
นา

ระ
บบ

เค
รื่อ

งค
อม

พิว
เต

อร
์แล

ะเค
รือ

ข่า
ย 

| [
M

icr
os

of
 O

ffi
ce

 E
xc

e 
Ad

va
nc

ed
 l 

20
19

]  
- ว

รา
ภร

ณ
์ ไต

รศ
ักด

ิศ์ร
ี 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 
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 คำสั่งบนแท็บ  Data 

 

เป็นแท็บท่ีรวบรวมคำสั่งที่ใช้ในการติดต่อกับฐานข้อมูล การเลือกข้อมูลจากโปรแกรมอื่น ๆการเรียงลำดับ
ข้อมูล การค้นหาและกรองข้อมูลขั้นสูง เป็นต้น  

 

 
 

กลุ่มคำสั่ง อธิบาย 
Get External Data กลุ่มคำสั่งที่ใช้ในการนำข้อมูลจากภายนอกมาใช้ภายในโปรแกรม Microsof Excel เช่น 

Access Text เป็นต้น และเรียกใช้ข้อมูลจาก Connection ที่สร้างการเชื่อมต่อกับข้อมูล
อ่ืน 

Connections กลุ่มคำสั่งที่ใช้ในการสร้างการเชื่อมต่อระหว่าง Worksheet และข้อมูลภายนอก 

Sort & Filter กลุ่มคำสั่งที่ใช้ในการจัดเรียงข้อมูล การกรองข้อมูล 

Data Tools กลุ่มคำสั่งที่ใช้ในการจัดการข้อมูล เช่น แยกข้อมูลเป็นคอลัมน์  การตรวจสอบความถูกต้อง
ของข้อมูล เป็นต้น 

Outline กลุ่มคำสั่งที่ใช้ในการจัด/กลุ่มยกเลิกข้อมูลในแต่ละรายการ สามารถสร้างยอดรวมแต่ละ
รายการ 

 

การนำเข้าข้อมูลจากเว็บไซต์  ( Import Data From Web ) 
 
 
 
 

 

การนำเข้าข้อมูลประเภท Text ไฟล์ ( Import Text Fi les ) 

Data 

2 

3 

1 
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การสรุปข้อมูลด้วย SubTotal  (Excel 2016 ) 
 

5 

4 

3 

2 

     โ ป ร แ ก ร ม  Microsoft Excel มี
ความสามารถในการทำงานร่วมกับข้อมูล
ในโปรแกรมอ่ืนๆ เช่น Text , Access เป็น
ต้น โดยการนำเข้า Text ไฟล์เรียกใช้คำสั่ง
ได้จากแท็บ Data >> From Text หรือ
เปิดไฟล์จากปุ่ม Office >> Open >> 
เลือกชนิดไฟล ์

1 

6 
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You can automatically calculate subtotals and grand totals in a list for a column by using the 
Subtotal command. 

- Subtotals are calculated with a summary function, such as Sum or Average, by using the 
SUBTOTAL function. You can display more than one type of summary function for each 
column. 

- Grand totals are derived from detail data, not from the values in the subtotals. For example, 
if you use the Average summary function, the grand total row displays an average of all of 
the detail rows in the list, not an average of the values in the subtotal rows. 
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 คำสั่งบนแท็บ  Review 

 

 เป็นแท็บที่รวบรวมคำสั่งเกี่ยวกับการตรวจสอบการสะกด ไวยกรณ์ ข้อความที่
พิมพ์ สร้างหมายเหตุ การป้องกันข้อมูลของแผ่นงาน การทำงานร่วมกัน เป็นต้น 

 

 
 

กลุ่มคำสั่ง อธิบาย 
Proofing กลุ่มคำสั่งที่ใช้ในการตรวจสอบการสะกดและไวยกรณ์ ข้อความที่พิมพ์ การแปลข้อความ 
Comments กลุ่มคำสั่งที่ใช้ในการการใส่หมายเหตุ (Comment) ให้กับเซล 
Changes กลุ่มคำสั่งที่ใช้ในการป้องกันการเข้าถึง Worksheet , Workbook การติดตามการแก้ไขเอกสาร เป็น

ต้น 
 

การใส่หมายเหตุให้กับเซล (Comment ) 
 
 

 

 

 

 

 

 

 

 

Review 

1 

3 

2 
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 คำสั่งบนแท็บ  View 

 

 เป็นที่รวบรวมคำสั่งในการจัดมุมมองการทำงานของเอกสาร แผ่นงาน ในขณะนั้น เช่น การ
ย่อ-ขยายเอกสาร การเปลี ่ยนมุมมองของเอกสาร เป็นแบบปกติทั ่วไป แบบเค้าโครง
หน้ากระดาษ (เหมือนใน MS Word) การสลับไปที่หน้าต่างอื่นๆ หากเปิดไว้หลายหน้าต่าง

การจัดเรียงเอกสารแบบ การแสดงเส้นสมมุติ (Gridline) เป็นต้น 

 
 

กลุ่มคำสั่ง อธิบาย 

Workbook Views กลุ่มคำสั่งที่ใช้ในการแสดงผลหน้าจอในการทำงาน และสามารถปรับเปลี่ยนได้ตามผู้ใช้ 

Show/Hide กลุ่มคำสั่งที่ใช้ในการแสดงหรือซ่อนไม้บรรทัด Gridlines แถบ Formular Bar แถบ
แสดงหัวคอลัมน์หรือแถว 

Zoom กลุ่มคำสั่งที่ใช้ในการย่อหรือขยายหน้าจอแสดงข้อมูล 

Window กลุ่มคำสั่งที่ใช้ในการแบ่งหน้าจอในการทำงาน เช่น การแบ่งหน้าจอในการทำการเป็น
หลายหน้า และสามารถสั ่งให้ตร ึงหน้าจอ การสลับการทำงานระหว่างหน้ าจอ 
(Window) การบนัทึกหน้าจอในการทำงาน เป็นต้น 

Macros กลุ่มคำสั่งที่ใช้ในการสร้างและและเรียกใช้ใช้งานคำสั่งขั้นสูง (Macros) 

 

มุมมองในการทำงานกับ  Workbook (Workbook View ) 
 
 
 
 
 

การตรึงแนวหรือการล็อกแถว/คอลัมน์  (Freeze Panes ) 
 

VIEW 
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คุณสามารถดูพื้นที่สองส่วนบนแผ่นงาน แล้วล็อกแถวหรือคอลัมน์ในพื้นที่หนึ่งด้วยการตรึงหรือแยกแนว 
(บานหน้าต่าง: ส่วนหนึ่งของหน้าต่างเอกสารที่แยกจากส่วนอื่นด้วยแถบแนวตั้งและแถบแนวนอน) เมื่อคุณตรึงแนว 
คุณจะเลือกแถวหรือคอลัมน์ที่เฉพาะเจาะจงที่ยังคงมองเห็นได้เมื่อเลื่อนแผ่นงาน  

ตัวอย่างเช่น คุณอาจตรึงแนวเพ่ือให้มองเห็นป้ายชื่อแถวและคอลัมน์ในขณะที่คุณเลื่อนไปมา ดังที่แสดงใน
ตัวอย่างต่อไปนี้ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

ชื่อแถวที่ถูกตรึงในขณะที่
เลื่อน Mouse ไปมา 

ชื่อคอลัมน์ที่ถูกตรึงใน
ขณะทีเ่ลื่อน Mouse ไปมา 

1 

3 

2
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การแสดง  Worksheet  ใน 2 หน้าต่าง (View Side By Side ) 
 
Make Comparisons Between Sheets Easier 

Sometimes we need to flip back and forth between two worksheets in order to compare 
numbers, copy and paste entries, or create formulas. In these instances, it can be much easier to 
look at the two (or more) sheets side by side. 

To accomplish this, we can use the New Window feature in Excel, as well as some desktop 
shortcuts to create a split screen view of the the sheets we want to look at simultaneously. It's a 
fairly easy habit to pick up and will save you lots of time and frustration in the long run. 
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 แนะนำแท็บ  Developer 

 

 เป็นแทบ็ที่รวบรวมคำสั่งเกี่ยวกับคำสั่งในการจัดทำ Marco เพ่ือใช้งานใน
ขั้นที่สูงขึ้น โดยคำสั่งให้โปรแกรมทำงานในลักษณะซ้ำ ๆ กันหลายครั้ง 
ตามรูปแบบ ชั้นตอนที่ได้กำหนดไว้ซึ่งก็คือชุดคำสั่งที่ได้รวบรวมไว้  เมื่อ

ต้องการใช้คำสั่งเหล่านี้ก็ต้องเรียกคำสั่งให้โปรแกรมทำงานในลักษณะซ้ำ ๆ กันอีก เรียกว่า Macro โดยแท็บนี้จะ
มองเห็นได้เม่ือผู้ใช้กำหนดให้แสดงเท่านั้น เนื่องจากเป็นคำสั่งระดับสูงที่ผู้ใช้งานทั่วไปอาจไม่ได้ใช้บ่อยนัก 

 

 

กลุ่มคำสั่ง อธิบาย 
Code กลุ่มคำสั่งที่ใช้ในการสร้าง/บันทึก Macro รวมทั้งการเขียนคำสั่งเพื่อควบคุมการทำงาน 

Controls กลุ่มคำสั่งที่ใช้ในการเพิ่ม Control ต่างๆ ที่จะนำมาใช้ในการแสดงผลข้อมูล เช่น Button , 
Combo Box , Check Box , List Box , Option Button , Group Box , Text Field เป็นต้น 

XML กลุ่มคำสั่งที่ใช้ในการจัดการ นำเข้าข้อมูล XML 

Modify กลุ่มคำสั่งที่ใช้ในการจัดการเกี่ยวกับคุณสมบัติของเอกสาร หรือที่รู้จักในฐานะข้อมูล Metadata 
(Metadata : ข้อมูลที่อธิบายข้อมูลอ่ืน ตัวอย่างเช่น คำต่างๆ ในเอกสารคือข้อมูล ส่วนจำนวนคำ
คือ metadata) คือ รายละเอียดเกี่ยวกับแฟ้มที่อธิบายหรือระบุแฟ้ม คุณสมบัติเอกสารจะ
รวมถึงรายละเอียด เช่น ชื่อเรื ่อง ผู้สร้าง เรื ่อง และคำสำคัญ ที่ระบุหัวเรื่องหรือเนื้อหาของ
เอกสาร 
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Workshop  :  การสร้างมาโครสำหรับลบข้อมูล  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Workshop :  การสร้างมาโครสำหรับรวม  Worksheet 
 

Sub MergeSheet () 
    This is script for merge sheets in to one 
    Dim J As Integer 
    On Error Resume Next 

2.2 

2.2 

2.3 

3.2 

3.1 

3.3 คลิกเซล D1 

4 

1 
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    Sheets(1).Select 
    Worksheets.Add 
    Sheets(1).Name = "Combined" 
    Sheets(2).Activate 
    Range("A1").EntireRow.Select 
    Selection.Copy Destination:=Sheets(1).Range("A1") 
    For J = 2 To Sheets.Count 
        Sheets(J).Activate 
        Range("A1").Select 
        Selection.CurrentRegion.Select 
        Selection.Offset(1, 0).Resize(Selection.Rows.Count - 1).Select 
        Selection.Copy Destination:=Sheets(1).Range("A65536").End(xlUp)(2) 
    Next 
End Sub 
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Workshop :  การสร้างมาโครสำหรับรวมไฟล์ข้อมูล  (Workbook ) 
 

Sub MergeFile () 
Sub simpleXlsMerger() 
Dim bookList As Workbook 
Dim mergeObj As Object, dirObj As Object, filesObj As Object, everyObj As Object 
Application.ScreenUpdating = False 
Set mergeObj = CreateObject("Scripting.FileSystemObject") 
  
'change folder path of excel files here 
Set dirObj = mergeObj.Getfolder("D:\spss_2559-05") 
Set filesObj = dirObj.Files 
For Each everyObj In filesObj 
Set bookList = Workbooks.Open(everyObj) 
  
'change "A2" with cell reference of start point for every files here 
'for example "B3:IV" to merge all files start from columns B and rows 3 
'If you're files using more than IV column, change it to the latest column 
'Also change "A" column on "A65536" to the same column as start point 
Range("A2:IV" & Range("A65536").End(xlUp).Row).Copy 
ThisWorkbook.Worksheets(1).Activate 
  
'Do not change the following column. It's not the same column as above 
Range("A65536").End(xlUp).Offset(1, 0).PasteSpecial 
Application.CutCopyMode = False 
bookList.Close 
Next 
End Sub 
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 แนะนำการใช้งานโปรแกรมบนระบบ  Cloud 

 

ปัจจุบันการทำงานส่วนใหญ่จะเน้นการทำงานบนระบบ Internet ดังนั ้นหลายๆ เว็บไซต์จะ
ให้บริการการใช้งานพ้ืนท่ีบนระบบคอมพิวเตอร์ที่เกิดขึ้นเพื่อรองรับการทำงานของผู้ใช้งานในทุกๆ
ด้าน ทั้งด้านระบบเครือข่าย ด้านการจัดเก็บข้อมูล ด้านการติดตั้งฐานข้อมูล หรือการใช้งานซอฟต์

เฉพาะด้านในธุรกิจต่างๆ เป็นต้น โดยที่ผู้ใช้บริการไม่จำเป็นต้องติดตั้งระบบทั้งฮาร์ดแวร์และซอฟต์แวร์ไว้ท่ีสำนักงานของตนให้มัน
ยุ่งยาก แต่ผู้ใช้บริการสามารถใช้งานง่ายๆ ด้วยการเชื่อมต่อกับระบบ Cloud Computing ผ่านระบบอินเทอร์เน็ต 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Cloud 
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 แนะนำโปรแกรม  VDO Conference (Zoom vs Google Meet) 
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